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AFJ FFT 3010 AND FFT 3030 EMI RECEIVERS 

1. • GENERAL INFORMATION 

The information contained herein, is provided in connection with the usage of hardware and 

software of AFJ FFT 3010 and FFT 3030 EMI receivers. Members of the AFJ FFT 3000 family are:  

FFT 3010 

FFT 3030 

9 kHz 

9 kHz 

to 

to 

30 MHz 

300 MHz 

FFT 3110 

FFT 3100 

9 kHz 

30 MHz 

to 

to 

1000 MHz 

1000 MHz 

All information contained herein, is subject to change without prior notice and cannot be duplicated, 

copied or reproduced in whole or part, without prior written consent of the owner:   

AFJ Instruments, Via Gavirate 16, 20148 – Milan, Italy  

Phone: +39 02 91434850  

E-mail: sales@afj-instruments.com 

Website: www.afj-instruments.com  

All efforts have been made to ensure the accuracy of the contents of this document. However, the 

supplier can assume no liability whatsoever for any errors in this manual or their consequences, 

direct and/or indirect.  

2. • SCOPE AND ORGANIZATION OF THE MANUAL 

This Manual contains information and procedures required to install and operate the members of the 

AFJ FFT 3000 family of EMI Receivers. The contents are generic for all models of Interference 

Measuring Receivers: specific paragraphs, or parts thereof, will describe functionalities and operating 

modes pertinent to the single models, whenever appropriate.  

The manual is divided into six sections as follows: 
 

Section A RF Emission Testing and FFT-Based EMI Receivers 

Section B General Information 

Section C System Installation 

Section D Operating Instruction 

Section E Report and Applications Notes 

Section F Manual Operations  

Section G Troubleshooting 
 

3. • STATEMENT OF COMPLIANCE  

The AFJ FFT 3010 and FFT 3030 EMI receivers are designed and built in accordance with CISPR 

Publication 16-1-1: “Specification for radio disturbance and immunity measuring apparatus and 

methods - Part 1: Radio disturbance and immunity measuring apparatus”.  
 

4. • WARRANTY  

Systems, options and accessories thereof, manufactured and shipped under the AFJ Instruments 

brand name, are warranted to be free from manufacturing defects for a period of twelve (12) months 

from the date of shipment. AFJ Instruments certifies that all products are tested and inspected to 

comply with the published specifications originating from the company. Calibration procedure 

includes Calculation of uncertainty using ISO model and traceability. Warranty is provided “Ex-

Works”: therefore, AFJ Instruments will be responsible of the Amendment of failures arising from 

ascertained manufacturing defects only.  
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−  Warranty will not be applicable in case of mishandling, unauthorized opening of the cabinets, 

improper use, and unauthorized repairs. In such cases, the warranty will be terminated.  

− A repair under warranty will not extend the original term of validity of the warranty itself.  

− All products or parts thereof, to be subject to a warranty operation, shall be shipped to the 

appropriate AFJ Instruments Warranty Centre, at Customer’s charge. 

− If a delivery back to the supplier is necessary, we recommend keeping the original transport case. 

In such case, refer to the following Return Procedure.  

5. • RETURN PROCEDURE  

To return  the FFT 3010 and FFT 3030 EMI receivers to AFJ Instruments, use the following procedure:  

−  Briefly describe the problem in writing (Service Requested form). Include the serial number of the 

item being returned; 

−  Give details regarding the observed symptom(s), and whether the problem is constant or 

intermittent in nature. If you have talked previously to AFJ representative about the problem, 

provide such information also;  

−  Package the unit carefully, using the original boxes and packing materials, if possible. If not, use 

the most protective envelope at disposal (Damages due to transport are not covered from any 

guarantee);  

−  Before return the system back to AFJ, wait for RMA number (Returned Material Authorization).  

The SW provided with the systems, is released “as-is” and is not covered by any warranty, not 

expressed, nor implied. However, AFJ Instruments is committed to correct, in a reasonable 

timeframe, all possible discrepancies reported with respect to the product specifications, through 

appropriate SW releases, free-of-charge.  

Any changes, additions, extensions of the SW or FW originally supplied, will render the system 

warranty invalid.  

6. • DISCLAIMER OF LIABILITY  

In no event shall AFJ Instruments be held liable for incidental or consequential damages of any kind 

whatsoever caused or alleged to be caused directly or indirectly by the usage and operation of 

products herein, to customers or any third party, including, but not limited to, loss of use, loss of 

profit or any commercial loss. Products described herein, do not imply any stated or alleged fitness 

for use, or any feasibility for business purpose, or expectation of profit. AFJ Instruments sole and only 

commitment is the compliance with the published product specifications. All information in this 

manual is given in good faith. However, AFJ Instruments shall not be liable for any loss or damage 

whatsoever arising from the use of this manual, or any errors or omissions herein. 

7. • WORKING CONDITIONS  

The allowed temperature range during use of the device is +0°C to +45°C. In cases of storage or 

transport this range may exceed by -20°C to +70°C.  

Working relative humidity shall be 30% to 75%, atmospheric pressure shall be 86kPa to 106kPa (860 

to 1060mba). System is not influenced by direct solar radiation.  

The EMI receiver is to use in dry and clean rooms. Avoid conditions like dust, air-humidity, danger of 

explosion and aggressive chemical environment. During use a sufficient air circulation is to realize. It 

is possible that condense water originates inside the device due to storage or transport conditions. In 

this case realize a period of 2 hours for acclimatize without use.  

Do not cover the ventilation holes. A distance of about 20 cm must be maintained between the rear 

panel of FFT 3010 and FFT 3030 and any wall and about 5 cm between the sides of FFT 3010 and FFT 

3030 and any other equipment or walls.  

NOTICE: FFT 3010 and FFT 3030 EMI receivers are supplied in proper special packaging due to their 

heavy weight. We strongly recommend you to save packaging for next transport.  
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CE MANUFACTURER DECLARATION OF CONFORMITY 
 

 
 
Manufacturer AFJ INSTRUMENTS SRL 

Via Gavirate 16 
20148 Milano 
Italy 

 
Product Types EMI receivers models FFT 3010 and FFT 3030 

 
We hereby declare that the aforementioned equipment complies with the requirements set out in 
the Council Directive on the Approximation of the Law of Member States relating to:  

- Electromagnetic Compatibility, Directive 2014/30/EC  

IEC 61326-1 Electrical equipment for measurement, control and laboratory use - EMC 
requirements - Part 1: General requirements  

 - IEC 61326-1 Class B (Emission) 

 - IEC 61326-1 (Immunity, laboratory) 

 
- Low Voltage Equipment Directive (2014/35/EC) and EN 61010-1 (“Safety of Electrical 

Measuring Apparatus”). 
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UKCA MANUFACTURER DECLARATION OF CONFORMITY 
 

Manufacturer AFJ INSTRUMENTS SRL 
Via Gavirate 16 
20148 Milano 
Italy 

 
Product Types EMI receivers models FFT 3010 and FFT 3030 

 
We hereby declare that the aforementioned equipment complies with the relevant requirements of 
the below referenced specifications. The unit complies with all applicable essential requirements of 
the directives. 

Electromagnetic Compatibility Regulations 2016 
 
Electrical Equipment (Safety) Regulations 2016 
 
The Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic 
Equipment Regulations 2012 

 
EN 61326-1:2021  Electrical equipment for measurement, control and laboratory use – EMC  

requirements - Part 1: General requirements  
 

 - EN / IEC 61326-1 Class B (Emission) 
 - EN / IEC 61326-1 (Immunity, Laboratory) 

 
EN 61010-1:2010 Safety requirements for electrical equipment for measurement, control, and 

laboratory use - Part 1: General requirements 
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SECTION A: RF EMISSION TESTING AND FFT-BASED EMI RECEIVERS 

A.1 • EMI 

EMI (electromagnetic interference) is the disruption of operation of an electronic device when it is in 

the vicinity of an electromagnetic field (EM field) in the radio frequency (RF) spectrum that is caused 

by another electronic device. 

The internal circuits of personal computers generate EM fields in the RF range. Also, cathode ray 

tube (CRT) displays generate EM energy over a wide band of frequencies. These emissions can 

interfere with the performance of sensitive wireless receivers nearby. If you have a wireless receiver 

of any kind and use it at the same time as you operate your personal computer, you will probably 

hear RF noise in the receiver that originates in the PC system.  

Moderate or high-powered wireless transmitters can produce EM fields strong enough to upset the 

operation of electronic equipment nearby. If you live near a broadcast station or in the downtown 

area of a large city, you have probably experienced EMI from radio or television transmitters. 

Cordless telephones, home entertainment systems, computers, and certain medical devices can fail 

to work properly in the presence of strong RF fields.  

Problems with EMI can be minimized by ensuring that all electronic equipment is operated with a 

good electrical ground system. In addition, cords and cables connecting the peripherals in an 

electronic or computer system should, if possible, be shielded to keep unwanted RF energy from 

entering or leaving. Specialized components such as line filters, capacitors, and inductors can be 

installed in power cords and interconnecting cables to reduce the EMI susceptibility of some systems.  

Radio frequency EMI emission tests are a common feature for EMC compliance of most electronic 

and electrical products. The purpose of these tests is not so much to check the operation of the 

product, as to ensure the protection of users of the radio spectrum when the product is used in their 

neighborhood. All commercial products, including some automotive applications, will be tested 

against the CISPR standards.  

A.2 • CISPR 16-1-1 INSTRUMENTATION 

IEC CISPR publication 16-1-1: “Specification for radio disturbance and immunity measuring apparatus 

and methods - Part 1: Radio disturbance and immunity measuring apparatus”, specifies the 

characteristics and performance of equipment for measuring EMI in the frequency range 9 kHz to 18 

GHz. It includes specifications for:  

− The Peak, Quasi Peak, CISPR Average, RMS / CISPR RMS measuring receivers including FFT-

based EMI receivers that can «sample and evaluate the signal continuously during 

measurement time» without any blind gap, like FFT 3010 and FFT 3030. 

− Absorbing clamps  

− Antenna 

− Tests Sites   

All commercial standards refer to CISPR 16-1-1 systems.  

The EMI receiver is the key element of either conducted or radiated emission measurements. 
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A.2.1 • CISPR 16-1-1 EMI RECEIVER  

The principal measuring receiver CISPR parameters are listed in Table A.1.  

 
Parameter Frequency Range 

 

Quasi Peak 

Charge time 

Discharge time 

Overload factor  

9 ÷150 kHz  0.15 ÷30 MHz  30 ÷ 1000 MHz  1 ÷ 18 GHz 

45 ms 

500 ms  

24 dB 

1 ms 

160 ms 

30 dB 

1 ms 

550 ms 

43.5 dB 

Not defined 

Not defined 

-- 

Peak 

τ Discharge / τ Charge 1.89 x 104 1.25 x 106 1.67 x 107 1.34 x 108 

General 

Bandwidths (-6 dB) 

Sine Wave accuracy 

200 Hz  

< ± 2 dB  

9 kHz 

< ± 2 dB  

120 kHz 
< ± 2 dB  

1 MHz 

< ± 2.5 dB 

Table A.1: CISPR 16-1-1 instrumentation characteristics 

Traditional EMI receivers are similar to superheterodyne spectrum analysers in all aspects, with 

additional features like pre-selector, pre-amplifier and different types of detectors like Peak, Quasi 

Peak and Average. The pre-selector consists of an input attenuator and a tunable band pass filter. It 

prevents the input mixer of the EMI receiver from overloading and also it improves the dynamic 

range. The pre-amplifier is a low noise amplifier, which it is used to improve the sensitivity of the EMI 

receiver. The main section of the EMI receiver are the IF filters and the detectors. The main detectors 

used for EMC measurements are Peak, Quasi Peak and Average. Peak detector responds 

instantaneously to the peak value of the signal and discharges rapidly. The Quasi Peak detector is 

nothing but a Peak detector with weighted charge and discharge times, which correct for the 

subjective human response to the pulse type interference. The Average detector measurements the 

Average value of the signal.  

This kind of measurements are very demanding and become very time consuming when large 

frequency ranges need to be swept or stepped or small resolution bandwidths are needed to achieve 

the necessary sensitivity. So, there was a strong request in reducing measuring time saving accuracy 

for this type of test. Besides, there was a felt need for time-domain measurements to evaluate the 

duration of discontinuous disturbances.  

Both these tasks are now easily and effectively and conveniently performed by the time domain 

output of an FFT-based measuring receiver.  

 

A.2.2 • FFT-BASED EMI RECEIVER  

The possibility to record the temporal behavior of the signal directly in time domain by the use of fast 

ADCs (analog-to-digital converters) and to apply FFT (Fast Fourier Transform) was recently exploited 

by International Committees. The application of the FFT can be interpreted as a parallel 

implementation of many filters at different frequencies. This technique has been well known for 

decades, but the capability of modern ADCs has reached lately a level where the application to EMC 

emission measurements becomes feasible. 

For CISPR-compliant emission measurements, FFT-based measuring instruments must sample and 

evaluate the signal continuously during the measurement time, as we have seen.  

This task is the most stringent request for an EMI receiver. 

In order to process the signal continuously and to enable the calculation of a real-time spectrogram, 

the frequency range from DC to 3 GHz is subdivided into many sub bands with a bandwidth of FFT-

band each. Every sub band is digitally down-converted to the baseband and the sub bands are 

processed sequentially. The block diagram is shown in Figure A.2.  
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A polyphase decimation filter is used for the in phase and quadrature channel to reduce the sampling 

frequency and to fulfill the Nyquist criterion. The output sampling frequency is twice the FFT-band, 

while the bandwidth is fixed by the FFT implementation. 

 

 
Fig. A.2: FFT-based EMI receiver block diagram 

The following approach was proposed by Braun from the Technical University of Munich. The signal is 

digitized continuously by an Analogue-to-Digital Converter System. By a digital down conversion 

(DDC) the measured signal is limited in its bandwidth (some dozens of MHz) and the sampling rate is 

reduced. After that the data is processed in a continuous way with the STFFT (Short Time Fast Fourier 

Transform) algorithm. The evaluation of the obtained spectrogram can be performed at several 

frequencies, with a great reduction of the measurement time. 

The system needs a digital dedicated hardware.  

In the next step, the CISPR-detectors must be modelled. Peak, average and RMS are straight forward 

mathematical operations, while the quasi-peak, the RMS-AV, and the CISPR-AV detectors can be 

modelled (also as a digital filter to model the instrument time constant). The detailed architecture 

diagram is shown in Figure A.3. 

 

 
Fig. A.3: FFT-based EMI receiver architecture diagram 
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A.2.3 • BANDWIDTHS 

If an interference signal spectrum is wider than the bandwidth of the instrument which measures it, 

then the indicated value will depend on that bandwidth. If it is narrower, then the indicated value is 

independent of bandwidth. This is the basis of the distinction between “narrowband” and 

“broadband” interference. If you are measuring known radio signals then you can tailor the 

measurement bandwidth to the characteristics of the signal, but this is not possible for EMC 

measurements, since the characteristic of the interference is almost by definition not known in 

advance. Therefore, the measuring receiver specification must include a defined value not only for 

the bandwidth, but for the shape of the filter that determines this bandwidth. The CISPR bandwidths 

are given in Table A.1. These are bandwidths at which the EMI receiver response is –6dB relative to 

the centre frequency.  

Only an EMI receiver whose bandwidth characteristics fully comply with this specification should be 

used for full compliance measurements. However, if you are only measuring narrowband 

interference, such as individual emissions from the harmonics of microprocessor clocks, the actual 

performance of the EMI receiver filters will have little or no effect on the outcome. This is the root of 

much of the confusion over bandwidth requirements.  

A.2.4 • DETECTORS  

In nature, interference emissions are not continuous at a fixed level. A carrier signal may be 

amplitude modulated, and both a carried and the broadband emission may be pulsed. 

That is, the measured level indicated for different types of modulation will depend on the type of 

detector in use. As a result, EMI receivers should have man-like response built-in: they must have a 

Quasi Peak weighting display to show the human perception of interference as a measured value. 

CISPR 16-1-1 specifies five principal detector types, Peak, Quasi Peak, CISPR Average, RMS and CISPR 

RMS. Radiated emissions limits are usually specified by standards using the Quasi Peak detector. 

Conducted emissions limits are specified for the Quasi Peak, the Average and RMS detectors. Full 

compliance measurements must use only the correct detectors. The difference between the 

detectors resides in how they respond to pulsed or modulated signals. All five types of detector give 

the same response to continuous unmodulated signals. The Quasi Peak and Average detectors 

weight the indicated value according to its pulse repetition frequency (PRF).  

The RMS detector, specified at § 7 of CISPR 16-1-1, indicates a value proportional to the square root 

of the PRF: this corresponds to RMS reading increasing by 10 dB when PRF increases by a factor 10 (1 

decade), or an increase by 3 dB per octave (factor 2) of the PRF. The Average detector, specified at § 

6 of CISPR 16-1-1, indicates a value proportional to the PRF, namely an increase in reading by 20 dB if 

the PRF increases by a factor 10 (1 decade), or an increase by 6 dB if the PRF is doubled (octave). 

The indicated level of pulsed interference is reduced by the degree in Figure A.4, as a result of the 

time constant and bandwidths given in Table A.1. 

The Quasi Peak detector weights the indicated value in terms of its perceived “annoyance factor”: 

low pulse repetition frequencies (PRF) are less annoying when experienced on broadcast radio and 

TV channels than high PRFs. The detector is specified in terms of its attack and decay time constants, 

and these are fairly straightforward to implement. The Average detector simply returns the Average 

value rather than the peak value of the interference with which it is presented. This can in principle 

be achieved with a simple low-pass filter whose time constant is slower than the slowest pulse 

repetition frequency of the input. An EMI receiver is calibrated using pulses of defined impulse area, 

spectral density and repetition rate.  
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Fig. A.4: PRF of PK, QP, RMS and Average detectors in CISPR Band A, B and C/D 

Most initial measurements are performed with the Peak detector, which as its name implies 

responds almost instantly to the peak value of the interference signal seen at its input. Provided that 

the EMI receiver dwell on each frequency for long enough to capture the maximum emission (this 

depends on the EUT’s emission cycle time) the Peak detector will always give the maximum output 

level. A list of frequencies at which high emission are detected, could be created, and these 

frequencies are measured with the requested detectors, which will give the reading which should be 

compared against the limit.  

As an example, most emission standards follow the simple procedure in Figure A.5.  

 

 

Fig. A.5: Flow chart for use of detectors 
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A.2.5 • OVERLOAD FACTOR  

The linear dynamic range of the RF circuits before the detector, and of the detector itself, must be at 

least equal to the dynamic range of the desired pulse weighting since the pulses are not to be 

compressed. This dynamic range according to the CISPR 16-1-1 specification (see table 1) can 

approach up to 43.5 dB, which means closer to 60dB in the EMI receiver design. If the EMI receiver 

did not adjust its gain continually to achieve the optimum level at the detector – acting as a spectrum 

analyzer, for instance – then the needed dynamic range would be increased by several tens of dB.  

A.2.6 • VSWR  

Still part of the CISPR 16-1-1 spec, is the requirement on input VSWR (Voltage Standing Wave Ratio). 

This is specified to be 2.0:1 with no input attenuation, dropping to 1.2:1 with ≥ 10dB attenuation in 

the range 9 kHz to 1 GHz; in the range 1 GHz to 18 GHz to be 3.0:1 with no input attenuation, 

dropping to 2.0:1 with ≥ 10dB attenuation. VSWR is related directly to measurement error due to 

mismatch. For a broad-spectrum EMI receiver (30MHz to 3GHz is two decades) the spec of 2:1 

without attenuation is quite hard to meet – many ordinary radio receivers cannot achieve this even 

over a narrow range. It is easy enough if you allow yourself some attenuation at the input, but then 

the EMI receiver sensitivity is degraded. The sensitivity requirement in CISPR 16-1-1 is expressed in 

the form that the noise component should not degrade the measurement accuracy by more than 1 

dB, which implies that the system noise floor must be at least 6 dB below the lowest level it is desired 

to measure accurately. The system noise floor is the EMI receiver noise plus the losses imposed by 

the transducer or antenna factor and connecting cables. In practice, the limiting performance is 

usually found at the top end of the radiated test around 1÷3 GHz. 
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SECTION B: GENERAL INFORMATION 
 

This Section contains a general description of the FFT 3010 and FFT 3030 EMI receivers, including: 

associated and optional accessories, equipment specifications and safety precautions.   

REFER TO MANUAL. THIS MANUAL IS AN INTEGRAL PART OF FFT 3010 AND FFT 3030 EMI 

RECEIVERS. THE SAFETY RULES AND PRECAUTIONS IN THE MANUAL MUST BE OBSERVED. AFJ 

INSTRUMENTS AND THEIR REPRESENTATIVES ACCEPT NO RESPONSIBILITY FOR DAMAGES TO 

PERSONS AND EQUIPMENT AS RESULTS OF NON-OBSERVATION OF THE RULES PRECAUTIONS IN 

THIS MANUAL.  

B.1 • EQUIPMENT DESCRIPTION 

FFT 3010 and FFT 3030 are microprocessor-controlled FFT-based EMI receiver covering the frequency 

range from 9 kHz to 30MHz / 300 MHz. These instruments are ideally suited for measurement of 

electromagnetic interference in accordance with the requirements of CISPR 16-1-1.  

The EMI receivers can also be used as selective RF voltmeters with a level range from 10 to 

+127 dBμV in 50 Ω coaxial systems. 

 

FFT 3010 and FFT 3030 EMI receivers are supplied with the following STANDARD ACCESSORIES: 

 

 Description  Qty 

1 110 / 230Vac, 50 / 60Hz, 50VA Class I power cord  1 

2 Unit-to-PC, LAN cross – cable, L=1.0 m (communication cable) 1 

3 F 3,15A FUSE 2 

4 3.5mm (Male) To 2.5mm (Female) stereo audio jack adapter 1 

5 AFJ EMI Software USB-key (containing: Operating Manual & Operating Software) 1 

6 Certificate of Calibration 1 

 

 

 

 
Fig. B.1: AFJ FFT 3010 EMI Receiver 

 

 

 



 

 

AFJ FFT 3010 AND FFT 3030 EMI RECEIVERS – Operating Manual – rev. 3.5 / 2023-03 

 

15 

 
Fig. B.2: AFJ FFT 3030 EMI Receiver 

 

B.2 • USAGE OF EXTERNAL PULSE LIMITER / ATTENUATOR  

High spikes produced by either LISN output or power supply transient noises, could damage the input 

stage of EMI receiver. FFT 3010 and FFT 3030 EMI receivers maximum allowed RF input is +127 dBµV 

in CW 50 Ω coaxial systems.  

 

WE STRONGLY RECOMMEND THE USAGE OF EXTERNAL PAT20M (20dB/1W ATTENUATOR AND PULSE 

LIMITER), SUPPLIED OPTIONALLY AND SEPARATELY WITH FFT 3010 AND 3030 EMI RECEIVERS.  

 

The PAT20M has been designed to fit between the LISN and the measuring instrument to protect the 

instrument from mains transients interface. The LISN itself will attenuate most of the transients on 

the mains supply – the real problem is the connection and disconnection of the EUT, which can cause 

up to 400V transients to appear at the RF outputs.  

 

WARNING: WHEN USING FFT 3010 AND FFT 3030 EMI RECEIVERS WITHOUT PAT20M ATTENUATOR 

(OR SIMILAR FIXED ATTENUATORS), ANY DAMAGE AT THE INPUT STAGE OF EMI RECEIVER IS NOT 

COVERED BY AFJ WARRANTY.  
 

 
Fig. B.3: PAT20M 1 W 20 dB attenuator & pulse limiter 
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B.3 • PRODUCT STRUCTURE  

The AFJ FFT 3000 family of equipment are FFT-based EMI receivers which makes use of the super 

heterodyne approach, converting the RF input signal into an intermediate frequency (IF), before 

detection. The main instrument subsystems are:  

− The pre-selector filters, tuned on the RF input frequency, to avoid spurious signals; 

− The attenuators and Preamplifier, to regulate the input signal; 

− The local oscillator, with a frequency lower or higher, with respect to the input signal; 

− The mixers, where the input signal and the local signal are intermixed, to generate the IF;  

− The ADC converter, to convert analog input signal to digital signal for DSPU; 

− The DSPU (Digital Signal Processing Unit), to elaborate the digital input signal giving the output 

signal with the basic functions that are processed by SW, providing the experimental values and, if 

requested the audio signal (this subsystem includes digital filters and detectors). 

The modular approach followed, enables the user to customize the system configuration according 

to his specific needs:  

 

− Model FFT 3010, is suitable for measurements across the CISPR 16-1-1 frequency bands A/B, 

from 9 kHz to 30 MHz; 

− Model FFT 3030, is suitable for measurements across the CISPR 16-1-1 frequency bands 

A/B/C from 9 kHz to 300 MHz; 

− Model FFT 3110, is suitable for measurements across the CISPR 16-1-1 frequency bands 

A/B/C/D from 9 kHz to 1000 MHz; 

− Model FFT 3100, is suitable for measurements across the CISPR 16-1-1 frequency bands C/D 

from 30 MHz to 1000 MHz. 

  

B.4 • OPTIONAL ACCESSORIES  

In order to fulfill all set-up requirements, as specified in the relevant sections of CISPR 16-1-X and the 

applicable Product Standards, the following OPTIONAL ACCESSORIES are made available: 

 

Item  Description  Order Code  

1 20dB/1W Attenuator and pulse limiter PAT20M 

2 High voltage probe, 30 dB attenuation TK 9420 

3 LISN, 9 kHz to 30 MHz single-phase, 2x16 A LS16C/10 

4 LISN, 9 kHz to 30 MHz three-phase, 4x32 A LT32C/10 

5 Absorbing clamp, 30 MHz to 1000 MHz (CISPR 14) MDS 21B 

6 Large Loop antenna system (LLAS) from 9kHz to 30MHz for 

magnetic field measurements (CISPR 15) 

VVL 1530 

7 CDNE from 30 MHz to 300 MHz for radiated emission 

measurements (CISPR 15) 

M2 or M3  

(for example) 

8 Dummy lamps for insertion loss measurement Linear Type  

(for example) 

9 Balance-to-unbalance transformer for insertion loss 

measurement 

BUT 

10 Van Der Hoofden test head from 20kHz to 10MHz for human 

exposure measurements to electromagnetic fields 

VDH 30  

11 Broadband antenna, from 30MHz to at least 1000MHz Any brand 

12 Near field probes (Large area) Any brand 
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B.5 • RELATED DOCUMENTS  

The EMI receivers belonging to the AFJ FFT 3000 family described herein, perform electromagnetic 

compatibility measurements in the domain of radiated noise, in accordance with (but not limited to) 

the following Harmonized European EMC Standards: 

 

CISPR 10  

Organization, rules and procedures of the CISPR: Gives the historical background, terms of 

reference, composition, organization, and types of documents of the International Special 

Committee on Radio Interference (CISPR). 

CISPR 11  

Industrial, scientific and medical (ISM) radio-frequency equipment - Electromagnetic 

disturbance characteristics -Limits and methods of measurement: The limits and methods of 

measurement laid down in this International Standard apply to industrial, scientific and medical 

(ISM) equipment as defined in clause 2, and to spark erosion equipment.  

CISPR 12  

Vehicles, motorboats and spark-ignited engine-driven devices - Radio disturbance 

characteristics -Limits and methods of measurement: The limits in this standard are designed to 

provide protection for broadcast receivers in the frequency range of 30 MHz to 1000 MHz when 

used in a residential environment. Compliance with this standard may not provide adequate 

protection for new types of radio transmissions or receivers used in the residential environment 

nearer than 10 m to the vehicle, boat or device  

CISPR 13  

Sound and television broadcast receivers and associated equipment - Radio disturbance 

characteristics - Limits and methods of measurement: Applies to the generation of 

electromagnetic energy from sound and television receivers for the reception of broadcast and 

similar transmissions and from associated equipment. 

The frequency range covered extends from 9 kHz to 400 GHz.  

CISPR 14-1  

Limits and methods of measurement of radio disturbance characteristics of electrical motor-

operated and thermal appliances for household and similar purposes, electric tools and electric 

apparatus - Part 1: Emission. This Standard applies to the conduction and the radiation of radio-

frequency disturbances from appliances whose main functions are performed by motors and 

switching or regulating devices, unless the r.f. energy is intentionally generated or intended for 

illumination. It includes such equipment as household electrical appliances, electric tools, 

regulating controls using semiconductor devices, motor-driven electro-medical apparatus, 

electric toys, automatic dispensing machines as well as cinema or slide projectors. 

The frequency range covered extends from 9 kHz to 400 GHz. 

CISPR 15  

Limits and methods of measurement of radio disturbance characteristics of electrical lighting 

and similar equipment. This Standard applies to the emission (radiated and conducted) of radio 

frequency disturbances from: all lighting equipment with a primary function of generating and/or 

distributing light intended for illumination purposes, and intended either for connection to the 

low voltage electricity supply or for battery operation; the lighting part of multi-function 

equipment where one of the primary functions of this is illumination; independent auxiliaries 

exclusively for use with lighting equipment; UV and IR radiation appliances; neon advertising 

signs; street/flood lighting intended for outdoor use; transport lighting (installed in buses and 

trains)  

The frequency range covered extends from 9 kHz to 400 GHz. 

CISPR 16-1-1  

Specification for radio disturbance and immunity measuring apparatus and methods Part 1-1: 

Radio disturbance and immunity measuring apparatus - Measuring apparatus. This part of 

CISPR 16 is designated a basic standard, which specifies the characteristics and performance of 

equipment for the measurement of radio disturbance voltages, currents and fields in the 

frequency range 9 kHz to 18 GHz. In addition, requirements are specified for specialized 

equipment for discontinuous disturbance measurements. The requirements include the 

measurement of broadband and narrowband types of radio disturbance. The requirements 

include the measurement of broadband and narrowband types of radio disturbance.   

CISPR 16-1-2  

Specification for radio disturbance and immunity measuring apparatus and methods - Part 1-2: 

Radio disturbance and immunity measuring apparatus - Ancillary equipment - Conducted 

disturbances.  

This part of CISPR 16 is designated a basic standard, which specifies the characteristics and 

performance of equipment for the measurement of radio disturbance voltages and currents in 

the frequency range 9 kHz to 1 GHz. Specifications for ancillary apparatus are included for: 

artificial mains networks, current and voltage probes and coupling units for current injection on 

cables. 
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CISPR 19 

Guidance on the Use of the Substitution Method for Measurements of Radiation from 

Microwave Ovens for Frequencies Above 1 GHz 

Describes a method of measurement for small microwave ovens (largest dimension less than 1 

m) and a separate method of measurement for large microwave ovens (largest dimension 

exceeding 1 m). 

CISPR 22  

Information technology equipment - Radio disturbance characteristics - Limits and methods of 

measurement.  

This Standard applies to information technology equipment (ITE). Procedures are given for the 

measurement of the levels of spurious signals generated by the ITE and limits are specified for 

the frequency range 9 kHz to 400 GHz for both class A and class B equipment. No measurements 

need be performed at frequencies where no limits are specified. The intention of this publication 

is to establish uniform requirements for the radio disturbance level of the equipment contained 

in the scope, to fix limits of disturbance, to describe methods of measurement and to standardize 

operating conditions and interpretation of results.  

CISPR 25  

Vehicles, boats and internal combustion engines - Radio disturbance characteristics - Limits and 

methods of measurement for the protection of on-board receivers.  

This Standard contains limits and procedures for the measurement of radio disturbances in the 

frequency range of 150 kHz to 2500 MHz. The standard applies to any electronic/electrical 

component intended for use in vehicles, trailers and devices. Refer to International 

Telecommunications Union (ITU) publications for details of frequency allocations. The limits are 

intended to provide protection for receivers installed in a vehicle from disturbances produced by 

components/modules in the same vehicle. 

CISPR/TR 28  

Industrial, scientific and medical equipment (ISM) - Guidelines for emission levels within the 

bands designated by the ITU.  

This technical report provides the guidelines for emission levels within the bands designated by 

the International Telecommunication Union (ITU) for industrial, scientific and medical (ISM) 

application. 

CISPR/TR 31 

Database on the characteristics of radio services.  

This Technical Report covers the rationale behind the actual database covering the characteristics 

of radio services. The objective of the database is to register those characteristics which are 

relevant for derivation and specification of limits for disturbance emissions from electric and/or 

electronic equipment, systems and installations. Committees responsible for generic and/or 

product emission EMC standards should use this information together with CISPR 23. This second 

edition includes the replacement of CISPR 23 as reference standard for the determination of 

limits by CISPR 16-4-4:2007 on "model for the calculation of limits for the protection of radio 

services". 

IEC 61000-6-3 

Electromagnetic compatibility (EMC) - Part 6-3: Generic standards - Emission standard for 

residential, commercial and light-industrial environments.  

This part of IEC 61000 for EMC emission requirements applies to electrical and electronic 

apparatus intended for use in residential, commercial and light-industrial environments. Emission 

requirements in the frequency range 0 Hz to 400 GHz are covered. No measurement needs to be 

performed at frequencies where no requirement is specified. 

IEC 61000-6-4  

Electromagnetic compatibility (EMC) - Part 6-4: Generic standards - Emission standard for 

industrial environments.  

This part of IEC 61000 for EMC emission requirements applies to electrical and electronic 

apparatus intended for use in industrial environments as described below. Emission 

requirements in the frequency range 0 Hz to 400 GHz are covered. No measurement needs to be 

performed at frequencies where no requirement is specified. This generic EMC emission standard 

is applicable if no relevant dedicated product or product-family EMC emission standard exists. 

This standard applies to a apparatus intended to be connected to a power network supplied from 

a high or medium voltage transformer dedicated to the supply of an installation feeding 

manufacturing or similar plant, and intended to operate in or in proximity to industrial locations. 
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B.6 • FFT 3010 AND FFT 3030 FRONT PANEL CONTROLS AND INDICATORS  

 

 

 
 

Fig. B.4: AFJ FFT 3010 and FFT 3030 Front Panel  

 
 
1 – POWER ON/OFF.  

 

2 – RF OUT: Internal signal generator output. Test signal range +50 dBμV to +95 dBμV for the 

frequency range from 9 kHz to 30 MHz. 

 

3 – RF IN: N-type 50Ω input connector  

−  for FFT 3010 EMI Receiver with CISPR Band A/B, f = 9 kHz ÷ 30 MHz; 

−  for FFT 3030 EMI Receiver with CISPR Band A/B/C, f = 9 kHz ÷ 300 MHz. 

 
4 – STATUS INDICATORS LEDS (from left to right): 

 

COLOUR  NAME  FUNCTION  

RED RF OUT  The LED is lit when the internal signal generator is activated 

RED  RF IN  The LED is lit during measurements in the CISPR Bands  
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B.7 • FFT 3010 AND FFT 3030 REAR PANEL CONNECTIONS 

 

Fig. B.5: AFJ FFT 3010 and FFT 3030 Rear Panel  

 

1 – POWER SOCKET for power cord (use Class I type only). 

 

2 – PC board with VGA/DVI interfaces, 4 USB ports, 3 audio jacks, 1 PS2-port for mouse/keyboard, 

LAN port (RJ-45 connector + Standard Category 5e cross – cable or better) for connecting the 

instrument to an external PC. 

 

3 – WARNING Labels: Maintain Ground Line to Avoid Electrical Shock & Line Voltage Selector Inside; 

No User Serviceable Parts Inside; Do Not Remove Covers; Refer Servicing To Trained Personnel; 

Replace Fuse Only With Fuse of Specified Type and Rating. Recycling Warning; CE marking; Made in 

Italy statement. 

 

4 – REMOTE CONTROL CONNECTOR for AFJ external devices (e.g. LS16C/10 and LT32C/10). 

 

5 – AFJ Product Label showing equipment Model, Serial Number, rated voltage and frequency of 

power supply. 

 

6 – AUDIO / OUT external audio demodulation output with volume adjusting control and loudspeaker 

(1 W RMS). 

 

7 – EXT. REF. 10MHz IN and OUT (signal amplifier). 

 

8 – COOLING FAN.  

 

Note: ALWAYS leave sufficient space behind the instrument to allow enough air circulation. Do not 

cover the ventilation holes. A distance of about 20 cm must be kept between the rear panel of FFT 

3010 and FFT 3030 EMI receivers and any wall. 
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SECTION C: SYSTEM INSTALLATION 

 

Check the outside of the carton package to assess possible shipping damage: in case of damage, possibly 

remove the device from the packaging, in presence of the Carrier. Keep the packaging material available 

for further inspection with the Carrier, in case the damage shows up after unpacking. In case of damage, 

immediately notify Carrier and local AFJ Distributor or Sales Office, for report. Do not try to install a 

damaged unit. After checking for device integrity, verify that all items listed and ticked on the PRODUCT 

CHECK LIST put inside the packaging, are duly present. If not, send immediate report to your vendor. If 

everything is OK, proceed in the INSTALLATION routine. 

C.1 • PREVENTION AND SAFETY NOTE 

The instruments are SAFETY CLASS I equipment and must be connected to an approved power supply 

socket, with proper earth wiring. Never interpose an extender cable without earth wire, between the 

socket and the devices. The protection fuses must be replaced exclusively with fuses of the same type, 

rating and speed specifications. 

Any adjustment, maintenance or repair operation on the EMI receivers, implying opening of the case, 

should possibly be carried out without power: if this turns impossible, such operations should be carried 

out by an authorized person, well aware of the hazards involved. 

The user is sole responsible of undertaking all necessary provisions for the safe usage of the EMI receivers. 

Power source check: on the rear panel, you will find a type plate. Please check whether the EMI receivers 

have been prepared for the correct power line voltage of your public power. If the power supply voltage is 

different please inform AFJ Instruments or your AFJ representatives. 

Connecting the EMI receivers to the power line: please use the supplied power cord for connecting FFT 

3010 and FFT 3030 EMI receivers to your public power supply. The power supply must have an earth 

safety wire. Please check the earth connection on your power outlet before you connect and turn on your 

AFJ equipment. 

C.2 • INSTALLATION PROCEDURE 

C.2.1 • SYSTEM 

FFT 3010 and FFT 3030 EMI receivers incorporate a last generation PC with WINDOWS 10 Embedded OS. 

Regardless of EMI Receiver model and SW version selected, a USB-stick is provided. Please contact AFJ 

Instruments or your local AFJ distributor for information about software updates always available free of 

charge. 

The calibration data are stored directly on NVM (non-volatile memory) of the FFT 3010 and FFT 3030 EMI 

receivers, so they do not need to be managed by the user.  

 

For the processing of test data coming from any of the AFJ FFT 3000 family instruments the minimal 

system requirements for external remote control PC are: 

− PC®- compatible system, with PENTIUM IV® or AMD® processor, 400 MHz or above 

− 512 MB-RAM or higher 

− 1024 x 768 pixel monitor (suggested) 

− LAN port 

− OS VERSIONS: Windows 8 (Home Premium, Professional and Ultimate) and Windows 10 (Pro, 

Enterprise) 
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C.2.2 • CONNECTION PROCEDURE  

FFT 3010 and FFT 3030 EMI receivers need to be connected to external keyboard, mouse and monitor 

output (VGA/DVI) for standalone usage (preferred mode), as well a direct connection via LAN-Ethernet to 

hosting external remote control PC, through either a UTP Category 5 cross cable (included in the delivery) 

or a standard Ethernet LAN 10/100 MB cable as shown at Fig. C.1. 

 
         External remote control PC                                                                                                                                  AFJ FFT 3010 EMI Receiver  

Fig. C.1: Connection procedure for FFT 3010 EMI receiver 

C.2.2.1 • STAND ALONE USAGE 

Once connected to external keyboard, mouse and monitor output (VGA/DVI) for stand alone usage, a 

working version of the operating software is already installed on the PC integrated in the FFT 3010 and FFT 

3030 EMI receivers. The operating software consists of two parts: the server and the client software.  

The server software starts automatically by itself at the start-up of the operative system (Fig. C.2):  

 

 
Fig. C.2: FFT 3010 EMI receiver system start-up 

If it does not start automatically, it has to be either run manually by double clicking the AFJ_FFT 3010 

(AFJ_FFT 3030) red icon (Fig. C.3) or recover the automatic start condition (see next paragraph C.2.2.3). 
 

 
Fig. C.3: FFT 3010 EMI receiver server software icon 

 

When the server software has completed the hardware configuration (Fig. C.2), also the client software 

starts automatically by itself. If it does not start automatically, you have just to start it manually either by 

double clicking the AFJ_FFT 3010 (AFJ_FFT 3030) blue icon on the Windows desktop or as an alternative, 

selecting Start => Programs => AFJ_FFT 3010 (AFJ_FFT 3030) under the Windows graphic user interface 

(Fig. C.4). It is possible to recover the automatic start condition with the creation of a basic task to run the 

client software at the start-up of the operative system (see next paragraph C.2.2.4). 
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Fig. C.4: Starting of the FFT 3010 EMI receiver client software  

The following software window appears (Fig. C.5): 

 

 
Fig. C.5: FFT 3010 EMI receiver IP address setting 

The IP address of FFT 3010 and FTT 3030 EMI receivers is set by default to 127.0.0.1 and it does not need 

to be modified by the end user. TEST button allows to check the status of the communication between the 

equipment and the PC integrated inside with the indication of system information (Fig. C.6). 
 

 
Fig. C.6: FFT 3010 EMI receiver system information 

 

Push RUN button to access the operating software for the first time (refer to next section D). If Show SW 

log checkbox is flagged, the Loading… window appears showing the sequence of system information data 

loading when the equipment starts to communicate with the PC integrated inside (Fig. C.7). 
 

 
Fig. C.7: Sequence of system information data loading  
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C.2.2.2 • REMOTE CONTROL USAGE 

In order to install the program to an external remote control PC with Ethernet port, please follow the next 

steps: 
 

PERFORM THE FOLLOWING STEPS 

STEP 1 - After connecting the EMI receiver to an appropriately grounded mains, ensure that all the 

electrically powered devices connected to the equipment in the measurement set-up are connected to a 

common ground. Connect the EMI receiver power cord to a grounded outlet, too.   

Connect via LAN-Ethernet the device to an external remote control PC through either a UTP Category 5 

cross cable or a standard Ethernet LAN 10/100 MB cable. 
 

STEP 2 – Insert USB-stick in an USB port, from Windows Explorer, locate the “FFT 3010 Receiver (FFT 3030 

Receiver)/Operating SW/AFJ_FFT 3010ClientSetup_XYZ_20XY (AFJ_FFT 3030ClientSetup_XYZ_20XY)” 

folder on your AFJ USB-stick and double click on “Setup” file (Fig. C.8).  

 
Fig. C.8 – Setup file for client software 

 

STEP 3 – AFJ EMI receiver software installation. 

The Installation Wizard starts automatically. 

On next window, to proceed forward click “Next >” (click “Cancel” to exit installation), see Fig. C.9. 

On next window, see Fig. C.10, you can accept the default parameters or as alternative “Browse…” a 

different path (or write directly a different folder name) for storing the installation files.  

  
Fig. C.9: AFJ EMI Receiver Setup Wizard window Fig. C.10: Select Installation Folder window  

 

Here you can also calculate the necessary disk space by clicking “Disk Cost” (about 9.1 Mb for AFJ EMI 

receiver software). 

You can install AFJ EMI Receiver for Everyone (all User Accounts listed in the Control Panel) as suggested, 

or only for the current user (not recommended). 

Now the installer is ready to install AFJ EMI Receiver Software on your computer. 

You can also go back to revise previous step by clicking “< Back” (or click “Cancel” to exit installation: this 

is the last warning). 
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Please click “Next >” to complete the installation (Fig. C.11). 

At the end, the message “AFJ EMI Receiver has been successful installed” appears, the Installation 

Complete window appears (Fig. C.12). 
 

  
Fig. C.11: Confirm Installation window Fig. C.12: Installation Complete window 

Now click Close to exit the installation procedure. 

 

Note: nevertheless the equipment is remotely controlled by an external PC, the AFJ Local Database is 

always located on PC integrated in the FFT 3010 and FFT 3030 EMI receivers with WINDOWS 10 Embedded 

OS at the following path (Fig. C.13): 
  

  C:\Program Files\Microsoft SQL Server\MSSQL10_50.SQLEXPRESS\MSSQL\DATA\ 
 

 
 

Fig. C.13: AFJ Local Database location 

Here you find for example for FFT 3010 EMI receiver the following two files: Db_FFT 3010.ldf and Db_FFT 

3010.mdf.  

Right click on each one at turn, setting their Properties => Security. Below you can find an example of the 

Security property you need to run the AFJ EMI Receiver Database for current user.  
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STEP 4 – AFJ EMI receiver software running.  

Once the server software has completed the hardware configuration of EMI receiver (see paragraph 

C.2.2.1), in order to run the client software on the external remote control PC you have just to start it 

either by double clicking the AFJ_FFT 3010 (AFJ_FFT 3030) blue icon on the Windows desktop or as an 

alternative, selecting Start => Programs => AFJ_FFT 3010 (AFJ_FFT 3030)  under the Windows graphic user 

interface (Fig. C.14).  

Note: the client software has not to be run in the operating system of the equipment for standalone 

usage. 
 

    
Fig. C.14: FFT 3030 EMI receiver client software icon 

STEP 5 – When the client software is running, it automatically looks for the equipment connected to the 

external remote control PC (Fig. C.15). 
 

 
Fig. C.15: FFT 3030 client software running 

 

If the connection between client software and the equipment is not possible automatically, the next step 

is to insert manually the right IP address of the EMI receiver to get the communication between the 

equipment and the external remote control PC.  
 

Pushing Go to remote Panel button, Fig. C.16 appears. 
 

 
Fig. C.16: FFT 3030 EMI receiver IP address setting 

 

To drive the EMI receiver by external remote control PC it is recommended to set static IP address in the 

Internet protocol (TCP/IP) Properties (from Control panel => Local Area Connection Properties) on both PC 

as follows: 

   

1. PC integrated in the EMI receiver  

IP: 192.168.1.2 

Mask: 255.255.255.0 

Note: please disable the Firewall on this PC (Fig. C.17) 
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Fig. C.17: Firewall setting in the PC integrated in the EMI receiver 

  

2. External remote control PC  

IP: 192.168.1.3 

Mask: 255.255.255.0 
 

 

After typing the IP address of the PC integrated in the EMI receiver (Fig. C.18) push RUN button to access 

the operating software for the first time (refer to next section D). 
 

  

Fig. C.18: FFT 3030 EMI receiver IP address setting 
 

 

TEST button allows to check the status of the communication between the equipment and the external 

remote control PC with the indication of system information (Fig. C.19). 
 

 
Fig. C.19: FFT 3030 EMI receiver system information 
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Push OFFLINE button to access the operating software in demo mode ( Setup and Report pages only) (Fig. 

C.20) to display the measurement results and to manage the database (refer to next section D).  
 

 

Fig. C.20: Operating software in OFFLINE mode 

 

If Show SW log checkbox is flagged, the Loading… window appears showing the sequence of system 

information data loading when the equipment starts to communicate with the external remote control PC 

(Fig. C.21). 
 

 
Fig. C.21: Sequence of system information data loading  

 

Note: When the EMI receiver is connected via LAN cable (either cross or standard), it is normal to receive 

a Limited or no connectivity warning: anyhow the communication between PC and EMI receiver is active 

and running properly (Fig. C.22). 

 
Fig. C.22: Limited or no connectivity warning indication 
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C.2.2.3 •  RECOVER OF SERVER SOFTWARE AUTOMATIC START  

To recover the automatic start condition of the server software, please follows the next steps: 
 

STEP 1 – In the PC integrated in the equipment, please open  
 

Control Panel -> System and Security -> Administrative tools ->Task Scheduler 
 

and Delete the old FFT3010Server (FFT3030Server)  task (Fig. C.23). 
 

 
Fig. C.23: Delete of FFT 3030 Server task 

STEP 2 – Create a new task (Create Task…) either with mouse right-click or with the command in the right 

panel (Fig. C.24). 

 

 
Fig. C.24: Creation of a new task 
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STEP 3 – In Create Task window please select Tab General and edit the name of the new task 

“FFT3010Server (FFT3030Server)”. On Security options section select Run whether the user is logged on or 

not checkbox and confirm Run with highest privileges checkbox.  

Proceed clicking on Change User or Group option (Fig. C.25). 

 

 
Fig. C.25: Tab General configuration 

Proceed clicking on Advanced option (Fig. C.26). 

 

 
Fig. C.26: Advanced option selection 
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Proceed clicking on Find Now and select Administrators on Search results section (Fig. C.27). 
 

 
 

Fig. C.27: PC Administrators configuration 

In the following window confirm with OK (Fig. C.28). 

 

 
Fig. C.28: PC Administrators confirmation 
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STEP 4 – In Create Task window please select Tab Triggers to create a new trigger. Select At log on and 

Any user. Be sure Enabled checkbox is selected (Fig. C.29). 

 

 
Fig. C.29: New Trigger configuration 

STEP 5 – In Create Task window please select Tab Actions and click on New….  to create a new action (Fig.  

C.30). 

 

  
Fig. C.30: New Action creation 
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In the following window (Fig. C.31) select from the list of the available actions Start a program. Click on 

Browse…  and select the file at the path  

 

C:\Users\utente\Local\Server\AFJ_R3300_Server.exe 

 

In Start in (optional) specify the directory   

 

C:\Users\utente\Local\Server\ 

 

and confirm with OK. 

 

 

 
Fig. C.31: New Action configuration 
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STEP 6 – In Create Task window please select Tab Conditions and disable all the options (Fig. C.32). 

 

 
Fig. C.32: New Conditions configuration 

STEP 7 – In Create Task window please select Tab Settings, select Allow task to be run on demand and If 

running does not end when request force it to stop checkboxes.  

Confirm with OK (Fig. C.33). 

 

 
Fig. C.33: New Settings configuration 
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C.2.2.4 • RECOVER OF CLIENT SOFTWARE AUTOMATIC START 

 

To recover the automatic start condition of the client software, it is necessary to create a basic task to run 

the client software at the start-up of the operative system.  

Please follows the next steps: 
 

STEP 1 – In the PC integrated in the equipment, please open  
 

Control Panel -> System and Security -> Administrative tools -> Task Scheduler 
 

Task Scheduler application can be also found from Windows Start menu (Fig. C.34). 

 

 

 
Fig. C.34: Windows Start menu 
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STEP 2 – In Task Scheduler window please create a new task to start client software selecting FFT3010 (FFT 

3030) folder in the left panel and Create Basic Task... in the right panel (Fig. C.35). 

 

 

 
Fig. C.35: Task Scheduler window 

STEP 3 – In Create Basic Task Wizard window please insert the task name and then click Next (Fig. C.36). 

 

 
Fig. C.36: Create Basic Task Wizard window 
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STEP 4 – In Create Basic Task Wizard window please choose When I log on option in the Trigger Task panel 

and then click Next (Fig. C.37). 
  

 
Fig. C.37: Task Trigger window 

 

STEP 5 – In Create Basic Task Wizard window please choose Start a program option in the Action panel  

and then click Next (Fig. C.38). 
 

 
Fig. C.38: Action window  
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STEP 6 – In Create Basic Task Wizard window in Start a Program window please click on Browse… button 

(Fig. C.39). 
 

 
Fig. C.39: Start a Program window 

 

STEP 7 – Please browse in C:\Program Files (x86)\AFJ\AFJ FFT3010 (AFJ FFT3030)\ folder, select 

AFJ_R3310_RECEIVER.exe application and then click Open (Fig. C.40). 
 

 
Fig. C.40: Browse window 
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STEP 8 – In Create Basic Task Wizard window after the selection of the required application please click  

Next (Fig. C.41). 
 

 
Fig. C.41: Selection of the required application 

 

STEP 9 – In Create Basic Task Wizard window please select Finish panel, verify the Name, Trigger and  

Action fields, select Open the Properties dialog for this task when I click Finish option and then click Finish 

(Fig. C.42). 
  

 
Fig. C.42: Finish window 
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STEP 10 – The new StartClient basic task is right now created and the StartClient Properties dialog box is 

open. Please select General tab and verify that Run only when user is logged on option is selected and 

then Select Run with highest privileges (Fig. C.43). 
 

 
Fig. C.43: General tab 

 

STEP 11 – Please select Triggers tab and click on Edit button to modify trigger settings (Fig. C.44). 
 

 
Fig. C.44: Triggers tab 
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STEP 12 – In Edit Trigger dialog box please verify that Begin the task field is set to At log on. In Settings 

section please select Any user option and click OK to confirm the new settings and to come back to  

StartClient Properties dialog box (Fig. C.45). 
 

 
Fig. C.45: Edit Trigger dialog box 

 

 

STEP 13 – Please select Actions tab and verify the status according to Fig. C.46. 
 

 
Fig. C.46: Actions tab  
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STEP 14 – Please select Conditions tab, in Idle section verify that Start the task only if the computer is idle 

for option is not checked and that Stop if the computer ceases to be idle is checked but the check box is 

not enabled. In Power settings deselect Start the task only if computer is on AC power and verify that Stop 

if the computer switches to battery power is checked but the check box is not enabled (Fig. C.47). 
  

 
Fig. C.47: Conditions tab  

 

STEP 15 – Please select Settings tab and verify the options according to Fig. C.48. 
 

 
Fig. C.48: Settings tab 
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STEP 16 – Please select History tab, verify the options according to Fig. C.49, then click OK to confirm the 

changes in StartClient Properties and to come back to Task Scheduler application. 
  

 
Fig. C.49: History tab 

 

STEP 17 – Right now the StartClient task shall be set in Running status. In the central panel of Task 

Scheduler application, the new StartClient task is added but Status is set to Ready according to Fig. C.50. 

Please execute Run in the right panel to modify the status. 
 

 
Fig. C.50: Status settings 
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STEP 18 – Right now the StartClient task has the proper status of Running (Fig. C.51). 

 

 
Fig. C.51: Status of Running for StartClient task 
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SECTION D: OPERATING INSTRUCTIONS 

D.1 • START OF THE APPLICATION 

When the operating software is running, it shows the Setup box of the EMI Receiver (Fig. D.1). This screen, 

with its five options Setup, Run Test, Analyze, Generator and Report, constitutes the so-called cockpit. 

 

 
 

Fig. D.1: The Setup box of the FFT 3030 EMI Receiver cockpit 
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D.2 • THE SETUP BOX 

The Fig. D.2 shows the Setup box of the FFT 3030 EMI Receiver.  
 

 
 

Fig. D.2: FFT 3030 EMI Receiver setup window  

The upper portion of Setup window is labeled Workspace and is filled with default data you can easily 

change to fit your own needs. 
 

Note:  You cannot change directly the data written in the workspace section, as they derive from the 

underlying database. You can instead create a new workspace or select one of the stored workspace data 

already created, by clicking New Workspace or Find Workspace respectively.  
 

You can create a new workspace by pressing the New Workspace button or from menu File => New 

Workspace. In both cases, the window Workspace Information appears and you can fill it with the 

following data: 

Display Name, Laboratory, D.U.T. (Device Under Test), Model, S/N (Serial Number) and Company (see Fig. 

D.3) in the New Workspace box. 

 
Fig. D.3: Setup New Workspace Information 
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By pressing Save the new workspace data will appear in your current workspace (see Fig. D.4). 
 

 
Fig. D.4: Choose your Workspace 

You can also manage to list, filter, load, modify and delete your saved Workspaces, by pressing the Find 

Workspace button or from menu File => Find Workspace. In both cases, the Workspace Management 

window appears (see Fig. D.5). This window is subdivided in the three sections: Filter (for research tasks), 

Workspace list and Workspace Information. The current workspace is already highlighted (selected) and its 

data are listed in the Workspace Information. 
 

 
Fig. D.5: Workspace Management window 

 

Any operation on workspaces can be performed easily, being the meaning of different fields intuitive for 

the user. 

The Filter is especially useful when you have many workspaces, which cannot fit in just a screen, and it 

enables you to find out your saved data in a fast way. 

You can filter your data according to one or more fields as Workspace Name, Company, Laboratory, DUT, 

Model, S/N: the found data appear immediately in the list and the first found in the Workspace Info 

section. 

You can select another workspace from the list by clicking on it: you can now Load or Delete Selected 

workspace with the below buttons. When a workspace is selected, all its data appears on the Workspace 

Info, so enabling you to modify them. After done that, press Save Modifications to store new data, Close to 

go back to main workspace screen. 

Note 1: Please, be aware that any modification you make on any saved workspace, will have an impact on 

all the data stored in that workspace and consequently in the whole Database you are working with. On 

the other hand, it is easy to make changes on all data taken during a measurement session. 

Note 2: The software is able to manage *.txt files with American indication (comma to separate 

thousands; dot to separate decimals), please leave unchanged the international settings of the PC with 

default configuration. 
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D.2.1 • OPERATING MODES 

Referring again to main Setup window (Fig. D.2), focus now on its upper right portion Operating Mode.  

Here you can choose one of the three operating modes: FFT Scan, Filter and Van Der Hoofden Test. 

These modes can be selected from the drop-down menu Operating Mode (Fig. D.6). 
 

   

Fig. D.6: Operating Mode selection among FFT SCAN, FILTER and VAN DER HOOFDEN TEST options 

 

FFT Scan Mode 

This is the default mode, being the most convenient mode for usage in most situations, allowing for fast 

and still reliable measurements. It is an important opportunity for experimenting with the FFT scan for any 

kind of interferences and be able to compare the results with the classic EMI receiver Sweep Modes. This 

task can be done easily with FFT 3010 and FFT 3030 EMI Receivers.  

FFT Scan Mode has a fixed frequency step of 46,875Hz from 9kHz up to 150kHz, 3kHz from 150kHz to 

30MHz and 24kHz from 30MHz to 300MHz and it can be operated with up three detectors at the same 

time and two different Limits (1 and 2). 

Refer to the left portion of Single Test Settings section for Trace 1, Trace 2 and Trace 3, each trace is 

checked against one of two limits (see Fig. D.7). 

In this mode, as well as the Sweep Mode, up to three different detectors can be selected at the same time. 

 

 

Fig. D.7: Setup of the Single Test Settings section for FFT Scan Mode with three traces at once 

The limits must be selected in the Limit section (in the left-lower part of Setup box, see Fig. D.8). 
 

 
Fig. D.8: Selection of limits in the Limit section 

 

Filter Mode 

This optional feature is especially suited to perform CISPR 15 Insertion Loss Measurements. 
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Van Der Hoofden Test  

FFT 3010 and FFT 3030 EMI receivers are automatically set according to the requirements of IEC 62493 Ed. 

2.0:2015-03 standard (Assessment of lighting equipment related to human exposure to electromagnetic 

fields) (Fig. D.9) for measurements with Van Der Hoofden Test Head model AFJ VDH 30.   
 

 
Fig. D.9: IEC 62493 Ed. 2.0:2015-03 standard requirements for measurement equipment 

On the Setup box the Single Test Settings will be automatically grayed out (Fig. D.10). 

 

Fig. D.10: Setup box settings for Van Der Hoofden Test operating mode 

 

 

D.2.2 • SYSTEM AUTOMATION 

You can also add the System Automation (Fig. D.11). 

 
Fig. D.11: Setup System Automation section for an AFJ LISN choice 
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For FFT 3010 and FFT 3030 EMI Receivers you can add either AFJ LISN LS16C/10 or AFJ LISN LT32C/10. 

Then you can choose the LISN LINE to measure. Possible choices are: 

- Line 1 or neutral for LISN LS16C/10 (single phase LISN); 

- Line 1, Line 2, Line 3 or Neutral for LISN LT32C/10 (three phase LISN). 

The phase is switched after you press the Start button in the Run Test box (the led on LISN front panel will 

switch on). 

If Auto option is selected, the measurement will be performed in sequence automatically on all the phases 

of the selected AFJ LISN. 
 

You can also choose the SyA Script function for the System Automation. In this case the LISN LINE gray out 

(Fig. D.12). 

 
Fig. D.12: Setup System Automation section for LISN choices 

This function requires a text script files to be programmed; this file allows you to make an automatic 

sequence of measurements. In this file you change test name, operator name, test conditions and 

specifications, test notes and you can send commands to RS232 serial port via the host PC. 

As soon START is pushed into 'Run Test', the SyA Script Log window appears and it is required to load the 

*.txt file that contains all the commands. 
 

Commands syntax is the following: 

OPEN232 COM1,9600,N,8,1 Open COM1 port  with baud rate=9600, parity=None, data bits=8, stop 

bit=1. 

Wait 2000   Wait for 2000 ms 

WR TN Test Name1  Write 'Test Name1' into Test Name field (TN = test name) 

WR OP Operator Name1 Write 'Operator Name1' into Operator field (OP = operator) 

WR CO Test Conditions1 Write 'Test Conditions1' into Conditions field (CO =condition) 

WR SP Test Specifications1 Write 'Test Specifications1' into Specifications field (SP= specification)  

WR NO Test note1  Write 'Test note1' into Test Note field (More Info button)  

WRITE232 COM1 *idn?  Send the string '*idn?' plus the blank space ' ' to COM1 port 

SWEEP    Run the test with Frequency Table settings 

//    Comments on single text line  

 

Serial port settings syntax commands: 

OPEN232  baud_rate, parity, data_bits, stop_bits 

Baud rate port settings: 2400, 4800, 9600, ..., 115200 

Parity:  None → N / Even → E / Mark → M / Odd → O / Space → S 

Data bits: Set either 8 or 7. 

Stop bits: To set nothing insert N, otherwise 1,1.5 or 2.  

 

LISN and Max hold settings syntax commands: 

LISN 0 select line N 

LISN 1 select line L1  

LISN 2 select line L2 (for LT32C only) 

LISN 3 select line L3 (for LT32C only) 

HOLD SET 2 enable MAX Hold and set the repetition number to 2 (defined by user) 

HOLD RST disable Max hold 
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D.2.3 • AN EXAMPLE OF SYA SCRIPT FILE 

The below script allows you to make 2 sweeps for both LISN lines, at the end saving Max hold of 4 scans. 

The final result is saved as “Test Lisn 1 - L1”. 

 
WR OP Operator1    

WR NO SyA Script: Script1.txt 

WR SP Max Hold 2 Rep. 

WR CO LISN LINE 0 

LISN 0            // Set LISN on N-line 

WR TN Test Lisn 1 - L0 

HOLD RST         // Max Hold Reset, delete previous traces 

HOLD SET 2       // Enable Max Hold with two repetitions 

SWEEP            // Sweep with two Max hold repetitions 

LISN 1           // Set LISN on L1-line 

WR CO LISN LINE 1 

WR TN Test Lisn 1 - L1 

SWEEP            // Sweep with two Max hold repetitions 

 

The below script allows you to make two sweeps for each LISN line saving the max hold of two repetitions 

on line L0 in a file (“Test Lisn 2 - L0”)  and the Max hold of two repetitions of line L1 in another 

file “Test Lisn 2 - L1”.  

The main difference is the HOLD RST command  of the third row from the end. 

 
WR OP Operator Name 

WR NO SyA Script: Script2.txt 

WR SP Max Hold 2 Rep. 

WR CO LISN LINE 0 

LISN 0 

WR TN Test Lisn 2 - L0 

HOLD RST 

HOLD SET 2 

SWEEP 

LISN 1 

WR CO LISN LINE 2 

WR TN Test Lisn 2 - L1 

HOLD RST 

HOLD SET 2 

SWEEP 

Another example runs two different tests with their names, operators, conditions, specifications. 

Between two tests the software runs a command to serial port, for example for settings an external 

hardware. 
 

OPEN232 COM1,9600,n,8,1 

WAIT 2000 

WR TN Test Name1 

WR OP Operator Name1 

WR CO Conditions1 

WR SP Specifications1 

WR NO Test note1 

WRITE232 com1 *idn? 

WAIT 2000 

SWEEP 

WR TN Test Name2 

WR OP Operator Name2 

WR CO Conditions2 

WR SP Specifications2 

WR NO Test note2 

WRITE232 COM1 *idn? 

WAIT 2000 

SWEEP 

Of course mode tests can be added to the file. 
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D.2.4 • LIMIT EDITOR (TOOLS MENU) 

The client software comes already with many measurements limits according to emission standards 

CISPR/EN 55011, 14, 15, 19, 22 (both Average and Quasi Peak, Group 1/2, Class A/B where applicable). In 

case of need, you can create your own limit. 

This task is easily done with the Limit Editor that you find on the menu Tools => Limit => Limit Editor (see 

Fig. D.13). 

 
Fig. D.13: Limit Editor selection 

In this box you can change the parameters of the current test Limit and its display configuration, with the 

possibility to Add New Limit, select another Limit (Selected Limit) and Delete Limit. It is possible to add a 

discontinuous limit according to the requirements for example of CISPR 25 standard with the definition of 

some frequency points with No Limit definition. A frequency point added with active NoLim flag allows to 

get a discontinuous gap from that frequency point up to the next one added with no active NoLim flag. 

The overall functionality (Fig. D.14) is similar to the Input Device Calibration Editor (See § D.2.6), so it does 

not need further explanation.  

At the end of editing, you can press the Save button to store your data and then the Close button to exit. 

 

 
Fig. D.14: Limit Editor parameters for an example of discontinuous limit 



 

 

AFJ FFT 3010 AND FFT 3030 EMI RECEIVERS – Operating Manual – rev. 3.5 / 2023-03 

 

53 

 

You can also Import / Export limits in XML format (version 1.0, Standalone) for using them in different 

XML-parsing programs (Fig. D.15). 

 
Fig. D.15: Limit Import / Export options 

 

With these two options (Import / Export) for Limit lines, different limits can be exchanged between two 

different databases (local or remote ones, no matter), allowing maximum flexibility for any EMI Receiver 

installation (Fig. D.16). 
 

 

Fig. D.16: Limit Import  

The XML-schema for a limit is: 

<?xml version="1.0" standalone="yes"?> 

<NewDataSet> 

  <Table> ... </Table> 

For the newly created limit IEC 60533 we have the following syntax: 
    

 <Nome> Name of the Standard (IEC60533-Table_2) </Nome> 

    <Descrizione> Description (IEC60533-Table_2 for bridge and deck zone) </Descrizione> 

    <Etichetta> Label (e.g. IEC60533-Table_2) </Etichetta> 

    <Punti> Points <DocumentElement> </Punti>  e.g. 

<Point>1</Point><Frequency>00000000389C7C41</Frequency>><Level>0000000000004B40</Level>  

    <Unit_Misura> dBµV </Unit_Misura> 

    <VarLinearLog> true/false (true = Lin / false = Log) </VarLinearLog> 

    <Detector> QP / Pk / C_RMS etc. </Detector> 
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In the Import Limit an XML file can be loaded and filtered according to Limit Name and its Description. 

After highlighting a Limit, press Import to import it onto your database (Fig. D.17). 

 
Fig. D.17: Limit Import of an XML-file 

 

D.2.5 • SINGLE TEST SETTINGS 

In the Single Test Settings section of the Setup window you can change the Frequency Start / Stop of your 

scan, Measurement Time, RF Input connector (RF IN), Attenuator Level (Manual attenuator mode only, 

please notice that AUTO Attenuator mode is not foreseen; Preamplifier) and Antenna / Probes, Cables and 

Amplifiers / Attenuator of the actual emission chain (Fig. D.18). 
 

 
Fig. D.18: Single Test Settings section 

 

Measurement Time can be set manually by the operator from 1ms to 5000ms when selecting a single trace 

with Peak detector only.  When another detector is selected (Quasi Peak, CISPR Average, RMS, CISPR RMS 

or a combination of them), Measurement Time will be set automatically to 1000ms independently from 

the selection of Peak detector and the operator will get a Warning message (Fig. D19).  
 

 
Fig. D.19: Measurement Time set automatically to 1000ms 

 

It is possible to select for each trace which limit (Limit 1, Limit 2 or both) to consider during Peak Search 

function and so to display into the table of the results the Distance from Limit of each trace (Fig. D.50). 
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In the Diagram section of the Setup window you can set the parameters for graphical data presentation of 

final spectrum (in the next window Run Test): 

Frequency Unit: Hz, kHz, MHz, GHz 

Display Unit: dBµV, dBm, dBµV/m, dBµA/m, dBA/m, dBµA, dBpW 

X-axis (Frequency) Start / Stop limits (Note: these limits are only valid for the output spectrum) 

Y-axis Start / Stop (Note: as above) 

Point per division: 1, 2, 5. 10, 20 points per division 

X division: 2, 5, 10, 20 divisions of X-axis 

Note: this option is available only with the Linear scale for X-axis choice as obvious. 

Scale: Linear or Logarithmic scales for X-axis: with the usual Log scale the X Division will grey out, while for 

Linear scale the X Division can be set 2 – 5 – 10 –20 (Fig. D.20); 

  
D.20: Diagram window. Left: Log scale for X-axis. Right: Linear scale for X-axis. 

Autoset Plot: with this option enabled, the graphic will show all measured points, according to X- and Y-

axis limits set by the user. When this option is disabled, if the range of the X-axis (Frequency) does not 

match the frequency range set for the measurement a Message Box (Fig. D.21) will appear to indicate the 

wrong setting. 

 
D.21: Plot Range error Message Box 

 

Enable Subrange Line: with this option enabled, a red vertical (dotted) separation line at the crossings of 

the subranges appears in the graphic during run-time. 
 

If you now click on the Run Test label you see the effect on your diagram. 
 

D.2.6 • INPUT DEVICE CALIBRATION EDITOR (TOOLS MENU) 

Before running your test, typically it is necessary to setup your Antenna or Probe, measurement Cable(s), 

and optionally also an Attenuator/Amplifier. 

This task is easily done with the Input Device Editor that you find on the menu: 
 

Tools => Input Device Calibration => Input Device Calibration Editor (Fig. D.22) 

 
Fig. D.22: Input Device Editor choice 
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The window of Fig. D.23 now appears. 

First of all you have to press the Add New Device button (on left-top of the window): so doing, a New 

Device will appear in the Selected Device drop-down menu and you can edit all its properties. 

In the middle section Input Device Info you can choose a different Name and Type of your device in use 

among Antenna/Probe, Cable or Amplifier/ Attenuator. 

You can adapt the range for X-axis, namely frequency in Hz (by default, this is the full range 9 kHz up to 1 

GHz) and the range for Y-axis, namely Level in dB (by default, this is ±20 dB). For this task, you can use the 

up/down arrow (in this case the graphic will be updated automatically), or directly editing the values with 

the keyboard and then pressing Enter to redraw the graphic. 

On the Points section you can enter the couple Frequency / Level [dB], and press Add. The data points are 

ordered as you enter them, but you can Reorder or Remove point. 

 

 
Fig. D.23: Edit Input Device Calibration window 

You can press the Save button to store your data, the following message appears (Fig. 24): 

 

 
Fig. D.24: Device calibration updated confirmation 

In the next page, we have set the typical parameters for the device calibration of an external attenuator 

20 dB Attenuator (Fig. D.25) and one for a log-periodical antenna (Fig. D.26). 
 

In the first case, all data were entered manually, by adding them directly in the Input Device Calibration 

Editor.  
 

In the second case, the data were imported with the function “Load From File”. For this action, you need 

to write down a simple Text file with two tab delimited fields - use Export Text (tab delimited) from Excel, 

Notepad or a similar editor - with the couple values of frequency expressed in Hz and the antenna factor. 
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An example of a such file is here: 
 

270000000 15.51 

275000000 15.22 

280000000 15.24 

285000000 14.98 

290000000 14.87 etc. 

 
D.25: Input Device Calibration parameters for an external 20 dB Attenuator  

 
D.26: Input Device Calibration parameters for a log-periodical antenna 
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The Load from File button allows you to import data from a file. The file must contain all the couples 

Frequency / Value (dB), separated by a blank space. 

 

It is possible to protect with User / Password the access to the Input Device Calibration Editor .  

See § D.2.10 for further information. 
 

D.2.7 • TOOLS MENU 

The other commands found in the Tools menu are as shown in Fig. D.27: 

 

 
D.27: Commands of the Tools menu 

 

Van Der Hoofden Test for calculating F factor from peak detector measurement sweep into the 

frequency range f=20kHz÷10MHz when using FFT 3010 and FFT 3030 EMI Receivers with Van Der Hoofden 

Test Head model AFJ VDH 30 according to IEC 62493 Ed. 2.0:2015-03 standard (Assessment of lighting 

equipment related to human exposure to electromagnetic fields) (Fig. D.28). 

 

 

Fig. D.28: Van Der Hoofden Test Software Tool 

With Test Data you select where to find (either from local database or from file) the measurement result 

obtained with VDH 30.    

With Load Test the measurement result is selected and loaded. 

Pushing GO you get the F factor with either “PASS” (F≤1) or “FAIL” (F>1) indication (Fig. D.29), with the 

possibility to generate at the same time an output *.txt file (Generate Output File) with the following 

information:  

frequency (Hz); test level (dBµV); current density Jcap(f) (A/m2); electric field Ecap(f) (V/m) 
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With Generate Report you automatically create the report with all the information about measurement 

with VDH 30. 

 

Fig. D.29: Van Der Hoofden Test Result 

 

D.2.8 • CUSTOMIZE (TOOLS MENU) 

From this menu, you can change the palette color appearance of the software windows/report and the 

information showed in the report. 

Customizing your Colors 

Tools => Customize => Colors  

Here you can change colors for Software Display and Print/ Report (Fig. D.30).  

The colors for the lines and the Max Hold lines with different detectors (Peak, QPeak, C_AVG, 

RMS/C_RMS) as well as for limits 1 & 2 and the Reference line can be changed at will. 

The Plotters colors refers to background, axis and grids of the spectrum in the Run/Analyze mode. For 

instance, you can set the background to white (255, 255, 255 RGB) instead of default black.  

 

 
D.30: Color Theme Editor 
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The first time you open this window, the option “Ask for Automatic Limit Curve Color Setting” is checked. 

If you leave it such way, then the following window will appear (Fig. D.31): 

 

  

Fig. D.31: Automatic Limit Color Settings for QP/AVG limits 

If you answer “Yes” then the other flag for “Automatic Limit Curve Color Setting” will be checked. 

If you answer “No” and “Don’t ask anymore” then the flag for “Ask for Automatic Limit Curve Color 

Setting” will be unchecked. 
 

Customizing your Reports 

Tools => Customize => Report  
 

In this window (Fig. D.32), you can edit some Report options, namely Report Title  & Comments (three 

lines possible). You can set also the “Show Date and Time” & “Show Subrange Settings” options. 

 
Fig. D.32: Report Options 

 

D.2.9 • OPTIONS (TOOLS MENU) 

Tools => Options => Peak Search Setting 

Peak Search Settings lists the parameters for Peak Search (appropriate for evident peaked spectra) and 

Max Search (for smoothed spectra, with no evident peaks).  A limit must be set to get results of both 

searches. Threshold (dBµV), Peak Escl (dB), Max Peaks Number, Threshold From Limit (dB) and Show All 

Detected Peaks  (Fig. D.33).  

   
Fig. D.33: Peak Search Settings 
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Note: The Peak Search will be effective only if a Limit is selected and associated to the detector of the 

Trace 1 in the Single Test Settings part of the Setup cockpit (Fig. D.34): 

 

Fig. D.34: Limit selection on Single Test Settings section 

Threshold (dBμV): this parameter allows to set a minimum limit to the max/peak search routine, i.e. no 

peaks are considered below this level. The default value is -10dBµV, which is below the noise limit. So, in 

practice, that means that all peaks are considered. This line settles the threshold under what the peaks 

must be cut out from the inquiry, it is a factor which distinguish a peak from the nears.  

Peak Escl (dB): this parameter allows to search only the peaks having a difference of more than [Peak Escl] 

from the local minima just aside the peak. The default value of this parameter is 6dB.  

Max Peaks Number: is the number of peaks to retain for each scan: this field allows setting an upper limit 

to the number of peaks to be considered in the table (max. 200 peaks). 

Threshold From Limit (dB): this parameter allows to set the distance from the limit for considering the 

max/peak search routine, i.e. peaks with a distance from the limit bigger than this value are not 

considered. The default value is 10dB. 

Show All Detected Peaks (dB): all the values of the detectors used during the measurement associated to 

the detected peaks by the max/peak search routine will be shown. 

 

Note: “Threshold”, “Peak Escl” and “Threshold From Limit” parameters distinguish various kinds of peaks 

and their maximum values, to help the choice of the most significant disturbances. Due to difficulty of 

automatic max peak selection, it is always possible to approach and complete the inquiry in manual mode. 

 

Tools => Options => Plot Screenshot Settings  
 

The Plot Screenshot Settings window lists Width/Height pixel size for the output bitmap of the working 

spectrum. Default Plot Screenshot Size is 710 х 425 pixel but it is recommended to set it at least double 

(1420 x 850 pixel). 

 

Tools => Options => Language  
 

Selection between English (default) and Chinese. 
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D.2.10 • MANAGE ADMIN PASSWORD (TOOLS MENU) 

It is possible to protect with User / Password the access to the Input Device Calibration Editor  selecting: 
 

Tools => Manage Admin Password (Fig. D.35) 
 

 

 
Fig. D.35: Manage Admin Password selection 

 

User / Password are set by default to Admin / Admin and without any updating the User Name / Password 

Message Box will not appear when accessing the Input Device Calibration Editor.  

For updating the Password it is necessary to input the old Password and the new Password with the 

consequent confirmation (Fig. D.36). 
 

 
Fig. D.36: Password updating 

After pushing OK the Message Box with Updated Admin Password confirmation will appear (Fig. D.37). 

 
Fig. D.37: Updated Admin Password confirmation 

After updating the Password when accessing the Input Device Calibration Editor  the User / Password 

Message Box will appear (Fig. D.38). 

 
Fig. D.38: User / Password Message Box 
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D.2.11 • DATABASE (TOOLS MENU) 

When the database size exceeds 50% of the available space, a warning message appears at the bottom of 

the Setup box (Fig. D.39): 
 

 

  
Fig. D.39: Warning message when database size exceeds 50% of the available space 

 
 

In case the database size exceeds 80% of the available space, further the warning message at the bottom 

of the Setup box (Fig. D.40) another warning message in a separated window appears with the 

recommendation to delete some old or unnecessary test data to reduce the database size (Fig. D.41). 
 

 

 
Fig. D.40: Warning message when database size exceeds 80% of the available space 

 

 
Fig. D.41: Warning window when database size exceeds 80% of the available space 

 

 

It is possible to manage the database selecting: 
 

Tools => Database (Fig. D.42)  
 

 

 
Fig. D.42: Database selection 
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Tools => Database => Backup  
 

To copy the actual database in the backup folder created automatically by the software: 

 

C:\Users\...\Documents\AFJ\DB\BACKUP 
 

After completing successfully the backup of the actual data base (*.bak file) a confirmation message will 

appear (Fig. D.43). 
 

 
Fig. D.43: Database backup confirmation 

 

Tools => Database => Restore  
 

To restore a previous copy of the database loading a *.bak file from the list (Fig. D.44). 
 

 
Fig. D.44: Selection of the database file to restore  

 

After completing successfully the restore of a copy of the database (*.bak file) a confirmation message will 

appear (Fig. D.45). 

 
Fig. D.45: Database restore confirmation 
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Tools => Database => Delete Tests  
 

To delete from the actual database all the tests before of a date selected by the operator (Fig. D.46).  

 

  
Fig. D.46: Delete tests before a date defined by the operator 

 

After completing successfully the deletion of all the tests a confirmation message will appear (Fig. D.47).  

 

 
Fig. D.47: Deletion confirmation 
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D.3 • RUN TEST BOX 

In the Run Test box (second label of the cockpit), you can make a measurement and analyze it in a quick 

but still effective way.  

To begin the run procedure, select the Start button in the Frequency section (by default, it shows the last 

performed measurement), the box depicted in Fig. D.48 will appears. 

 

 

Fig. D.48: Frequency section of Run Test Box 

 

The scan/sweep will now proceed according to all the parameters (frequency ranges, detectors, limits, 

traces, etc.)  you have chosen in the previous paragraphs (Fig. D.49).  
 

 
Fig. D.49: Frequency section of Run Test Box during measuring 

 

Selecting Pause button the measurement will be interrupted manually by the operator and such button 

will become red indicating such condition (Fig. D.50). 
 

 
Fig. D.50: Frequency section of Run Test Box during pausing condition 

 

Selecting again Pause button the measurement will continue, meanwhile with Stop button the 

measurement will be interrupted definitively by the operator.  
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If Auto Save Test is not flagged (default choice), then at the end of each measurement, the following 

window appears (Fig. D.51): 
 

 

Fig. D.51: Test terminated saving confirmation 

If Auto Save Test check is flagged, automatically saving of test results without user confirmation is enable.  
 

At the end of the measurement you can save the test with its name and perform a quick analysis directly 

from this window (for a detailed analysis, please, refer to next § D.4).  
 

In our example, the conducted emission measurement on the EUT is performed from 150 kHz to 30 MHz 

in the FFT Scan mode with Peak, Quasi Peak, CISPR Average, Bandwidth 9 kHz, with 1 s measuring time.  

The result of the actual measurement is shown in Fig. D. 52, as seen from the Run Test box. 
 

 
Fig. D.52: A frequency spectrum of conducted emission measurement from 150 kHz to 30 MHz 

 

D.3.1 • RUN TEST SECTIONS 

The Setup section shows: 

- Detectors in use, namely PK (green), QP (yellow), C_AVG (violet) and the value of the internal 

Attenuator or the use of the internal preamplifier (Preamp); 

- the presence / absence of any Probe/Antennas in use during the measurement; 

- the presence / absence of any Cable in use during the measurement; 

- the use of an external pulse limiter (for example AFJ PAT20M attenuator & pulse limiter) as 

Amplifier/Attenuator.  
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The Quick Analyze section is the most important section where the measurements can be checked (Fig. 

D.53). 

 
Fig. D.53: Quick Analyze section 

 

The Peak Search function will show the following table sorted by Distance from Limit (Fig. D.54). 
 

 
Fig. D.54: Peak Search table of the actual spectrum, ordered by Distance From Limit 

Note: A sort by either Frequency or Amplitude (in ascendant order, from the lowest value) is also possible 

from the Sort By drop-down menu.  
 

It is possible to add manually more peaks to include on the measurement report.  

For manually modifying the results of the Peak Search function: 
 

- Selecting “Add with click” and with mouse right-click on the graphic it is possible to add a row to the 

table;  

- “Del Row” deletes the selected row; 

- “Enable All” enables the visualization on the graphic of all the peaks included into the table; 

- “Disable All” disables the visualization on the graphic of all the peaks included into the table; 

-  “Clear Table” deletes all the rows of the table. 

 

Report function allows to generate a report including measurement sweep and peak search table.  
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If a Limit is not selected and associated to the detector of the Trace 1 in the Single Test Settings part of the 

Setup cockpit, selecting the Peak Search function the following warning message will appear (Fig. D.55): 

 
Fig. D.55: Peak Search function warning message 

You have also the choices or by clicking directly on the table headers labeled as Meter Read [dBµV], 

namely the reading at main EMI receiver RF-input, Measured Level [dBµV], namely the overall chain 

reading (including the effect due to any cables, antennas, amplifier/attenuators), Limits [dBµV] and Limit 

Distance [dBµV] (namely the difference between the measured level and the limit at one frequency), 

clicking once for descendant order and twice for ascendant order: 

    or     

     or     

     or     

     or     

Fig. D.56: Ordering Peak Search table by Meter Read., Meas. Level, Limits, Limit Distance. 

It is possible to make a manual Zoom in any spectrum window in two steps: 1) holding down the Shift-key 

(↑) and then lem-clicking and moving the mouse in a rectangle while holding the mouse button (Fig. 

D.57 A); 2) after you release it a blue rectangle appears and the area is zoomed (Fig. D.57 B): 

 

→

  

A B 

Fig. D.57: Manual Zoom on Emission Spectrum 

If you want to come back to the initial view (without Zoom), you can press the Reset Zoom button in the 

Quick Analyze section (Fig. D.53). 

 

The Clear Ref. Curve button in the Quick Analyze section (Fig. D.53) allows to clear the spectrum loaded 

pressing Load Reference button in Run Test window and select a test from the list (Fig. D.60). 

 

You can use the Max Hold function by clicking Max Hold button in the Run Mode section of the Run Test 

box and set if you want to perform a Continuous Sweep as well. Pressing Max Hold button the function will 

be activated and the button will switch its name to Reset in red color (Fig. D.58).  
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A  B 
 

Fig. D.58: Setup Max Hold section. A: Max Hold inactive; B: Max Hold active, with Continuous Sweep ON 
 

Selecting Continuous Sweep function the measurement sweep will be repeated until the operator stops 

the test manually; selecting “Enable Pause” function at the end of each measurement sweep the test 

system will be in “Pause” status showing a Message Box to give the possibility to decide when to continue 

with the next measurement sweep (Fig. D.59). 
 

 
 

Fig. D.59: Pause Message Box  

At this point, all traces and limits in the Single Test Settings are frozen to their current states and any 

change to them is not possible while Max Hold is active.  

Click Reset to make Max Hold inactive and go back to single scan measurements. The red script Max Hold 

Active reminds you the Max Hold active state. 

 

By pressing Screenshot button, it enables the saving of the measurement diagrams on a *.JPG, *.PNG, or 

*. BMP file. A Save as type dialog opens with Browse for directory and filename. In order not to less any 

detail of your image, but still save disk space, the PNG-format for your plot is suggested (Fig D.60 and 

D.61). 

 
Fig. D.60: Screenshot, Export Data and Load Reference buttons 

 

 
Fig. D.61: Saving in JPG/PNG/BMP files 

 

By pressing Export Data button, it enables the saving of the measurement data on a text file *.txt that can 

be opened by Windows Notepad or similar Editor program, or can be imported in any spreadsheet 

application, being each field separated by semicolon (Fig. D.62). 
 

    

Fig. D.62: Text file saved with Export Data and imported in a spreadsheet (Excel) 



 

 

AFJ FFT 3010 AND FFT 3030 EMI RECEIVERS – Operating Manual – rev. 3.5 / 2023-03 

 

71 

 

In the Test Info section of the Run Test box (Fig. D.63) you can write your personalized Test Name (default 

is Test Number with a progressive number), the Date of test (default is the current system date), the name 

of the Operator, the Conditions (usually the ambient test conditions) and Specification (Standards, limits, 

etc.).  

 
Fig. D.63: Test Info section of Run Test box 

You can introduce a list of possible different Test Name loading into the following directory: 
 

C:\Program Files (x86)\AFJ\AFJ FFT3010 (AFJ FFT3030) 
 

a text file called TestName.txt according to the example shown in Fig. D.64. 
 

 
Fig. D.64: Example of TestName.txt file 

After restarting the client software the Test Info section will show a list of possible different Test Name as 

per Fig. D.65. 

 
Fig. D.65: Test Info section of Run Test box 

 

Now you can click to More Info button and the Test Info window opens (Fig. D.66). 
 

 

Fig. D.66: Test Info window with three loaded images 

Here you can load up to three image sketches (in JPEG, PNG or Bitmap-format). They will appear in each of 

the three separate windows and one of them can be shown (check Show) in your main Run Test window 

(Fig. D.67), and you can add your Test Note about the current performed test. 
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Fig. D.67: Showing your Test Info image on Run Test window 

 

You can easily work with one or two markers, by left- and/or right-clicking in any part of the displayed 

spectrum window. Once activated, the first marker (red color) is driven by mouse left-click: you can put or 

drag-and-drop in any point of the spectrum to read its frequency and level. A mouse right-click will add 

the second marker (light-blue color) that behaves similarly at all, so enabling to make a second 

measurement. The two markers on the spectrum appear as apparent in Fig. D.68. 

 

   
Fig. D.68: Markers MK1 (red) and MK2 (light blue) in a spectrum 

The relative measurements of the enabled detectors values will be put in the upper right portion of the 

spectrum as depicted in Fig. D.69. 

 

 
Fig. D.69: Marker 1 an 2 readings in the displayed spectrum 
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When Van Der Hoofden Test operating mode is selected, at the end of the measurement the software will 

automatically show the F factor with either “PASS” (F≤1) or “FAIL” (F>1) indication (Fig. D.70). 

 

 
Fig. D.70: Van Der Hoofden Test result 

After saving the measurement data, it will be possible to load it and calculate again the F factor with the 

possibility to generate a test report using the software tool described at the paragraph D.2.7.  

 

If during a scan / sweep the SERVER COMMUNICATION FATAL ERROR message appears in the Run Test 

window (Fig. D.71), FTDI (Future Technology Devices International) component for internal USB 

communication of the equipment is not running properly and so please contact service center. 

 

 

                                                  

 

 

 

 

 

 

 

 

Fig. D.71: SERVER COMMUNICATION FATAL ERROR message in Run Test window 
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D.4 • ANALYZE BOX 

The Analyze box is useful for making an accurate analysis of your noise spectrum. It includes a single-

frequency real-time measurement with up to three different detectors at the same time. The initial 

appearance of the Analyze Box is apparent from Fig. D.72. 
 

 

Fig. D.72: The Analyze Test Box 

 

In the Analyze box you can Load Test, make a Peak Search, Export Data, Generate Report, make a 

Screenshot, Print and Reset Zoom (Fig. D.73).  

 
 

Fig. D.73: Test Tools menu of Analyze box 
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Load Test. This button has much utility and different options. It opens the Test Management window 

where you can load any of performed tests (Fig. D.74). 

Exactly as seen for the Find Workspace window, here you can use Filter for filtering your tests by Test 

Name / Operator, select one run test and change its stored data with Edit Info (press Save Modification for 

storing permanently your changes), you can Load a Test and it will automatically use as a reference 

spectrum for data analysis (it will superimpose to your actual real time running test), Delete Selected Tests 

(you can select more than one Test by clicking on each Test while holding down the Ctrl button) and Close.  

 

 
Fig. D.74: Test Management table for Load Test 

Pressing Show Settings button for the selected test, a window with all information on run test opens (Fig. 

D.75).  

 
Fig. D.75: Test Settings for a Load Test 

 

With reference to the example shown at Fig. D.71, the loaded Test is automatically use as a reference 

spectrum for data analysis reporting the waveforms with faded colors and the indication of the three 

detectors with (R), so PK(R), QP(R) and CAVG(R).  

Pushing the Start button, the real time measurement will be performed reporting the waveforms with 

standard colors and the indication of the three detectors will be as usual PK, QP and CAVG. The actual real 

time running measurement will be compared with the reference spectrum. The waveforms of the 

reference spectrum of the loaded Test can be enable / disable using the checkbox on right-lower part of 

the Analyze box, see Fig. D.72. 
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Peak Search. This will open the Peak Search – Analyze window (Fig. D.76) 
 

 
Fig. D.76: Peak Search - Analyze data, sorted by Distance from Limit 

Remarks: 

Antenna / Probe Factor [dB] is the antenna / probe factor expressed in dB 

Cable factor [dB]   is the cable factor expressed in dB 

Ampl / Att Factor [dB] is the attenuator factor for cable or amplifier/attenuator at the selected frequency 

in dB 

Detector  is the type detector in use: Peak, Qpeak, C_AVG, RMS, C_RMS  

Meter Read [dBμV] is the meter reading (V) expressed in dBμV  

Meas. Level [dBμV] is the measured level (expressed in dBμV 

Limit1 [dBμV]  is the value of the chosen limit 1 at the selected frequency 

Limit1 Dist [dB]  is the margin from limit 1 at the selected frequency: a negative value is below the    

limit (compliant), a positive value is over the limit (not compliant) 

Limit2 [dBμV]  is the value of the chosen limit 2 at the selected frequency 

Limit2 Dist [dB]  is the margin from limit 2 at the selected frequency: a negative value is below the    

limit (compliant), a positive value is over the limit (not compliant) 

 

Export Data. It enables the saving of the measurement data on a text file *.txt that can be opened by 

Windows Notepad or similar Editor program, or can be imported in any spreadsheet application, being 

each field separated by semicolon  (Fig. D.77). 
 

    

Fig. D.77: Text file saved with Export Data and imported in a spreadsheet (Excel) 
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Generate Report. It enables to easily create a report of the loaded test. After a few instants a window 

opens with your customized test report (See § E.2 for more details and information). 

 

Screenshot. It enables the saving of the measurement diagrams on a *.JPG, *.PNG, or *. BMP file. A Save 

as type dialog opens with Browse for directory and filename. In order not to less any detail of your image, 

but still save disk space, the PNG-format  for your plot is suggested. 

 

Print. This prints the display in a “XPS” document with the colors chosen in the Customize Colors => Print 

and Report section of the Color Theme Editor. Before printing, it opens the system Page Setup Print 

dialogue box, default page orientation is landscape, with 10 mm distance from all margins.  
 

Reset Zoom. This restore the display to its original form, by resetting any previous zoom (it works only if a 

Zoom was active). It is possible to make a manual Zoom in any spectrum window in two steps: 1) holding 

down the Shift-key (↑) and then lem-clicking and moving the mouse in a rectangle while holding the 

mouse button (Fig. D.78 A); 2) after you release it, a blue rectangle appears and the area is zoomed (Fig. 

D.78 B): 

  A

        →

  

  B 

Fig. D.78: Manual Zoom on Emission Spectrum 

If you want to come back to the initial view (without Zoom), you must choose Test Tools => Reset Zoom in 

the Analyze box.  
 

Checking the right side of the Analyze box, it is possible to add manually more points on the frequencies 

list selecting “Add with click” and using the mouse right-click on the graphic (Fig. D.79). 

Pushing the Start button, the real time measurement will be performed at all the frequencies of the list 

only with up to three different detectors at the same time. Pushing “Add Row” button, it is possible to add 

manually other new points on the frequencies list during the real time measurement (Fig. D.80). 
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Fig. D.79: Manual addition of points on the frequencies list 

 

 
Fig. D.80: Manual addition of points on the frequencies list 

 

“Delete Row” button allows to remove a selected frequency from the list and the “Clear” button allows to 

delete all the frequencies of the list. 

“Save To File” button allows to save into a file the list of all the frequencies of the table with all the last 

real time measurements performed. Such file can be loaded again selecting “Load A File” button. To 

update the real time measurements of all the frequencies of the table it is necessary to select “Update all 

Table” checkbox. 
 

The lowest part of the Analyze box window is the so-called Test Info (Fig. D.81), including the information 

saved in the Test Management window. These comprise Test Name (default one is Test Number with a 

progressive number), name of the Operator, Date of test (default is the current system date), Conditions 

(the ambient test conditions), Specification (Standards, limits, etc…) and Note. 
  

 
Fig. D.81: Test Info section of Run Test box 

 

Also into the Analyze window you can easily work with one or two markers with the same procedure 

described into the Run Test box (section D.3.1, Fig. D.68 and D.69). 

D.4.1 • THE MANUAL SETTINGS SECTION 

In the Manual Settings section you can choose up to three from five available detectors, by flagging their 

names. There is a sketch of the Analyze section with three detectors (Peak, QPeak, C_AVG) at Fig. D.82. 

 
Fig. D.82: Manual Settings of detectors, attenuators, etc. 
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The Attenuators (0 / 10/ 20 / 30 dB or PREAMP), the Input Offset (Auto/Disabled) and the Measuring Time 

(ms) can also be set by the end user. 

It is possible to include correction factors coming from external devices included into the measurement 

setup (Antenna/Probe, Cable, Amplifier/Attenuator).  

You can use the Max Hold function by flagging Max Hold option.  

It is possible to display on the diagram the average of the last N measurements with Peak detector only by 

flagging Peak Averaging option and introducing the number of measurements (in the example shown on 

Fig. D.82, N=4). 

The Automatic attenuator count indication shows how many times the internal attenuators has been set 

automatically by the system during measurement.  

 

D.4.2 • THE REAL TIME VISUALIZATION 

Further than the numerical indication of the table on the right side of the Analyze box, during real time 

measurement it is also possible to check the measured signal amplitude at the selected frequencies 

through waterfall visualization (Fig. D.83). To obtain the waterfall visualization it is necessary to move 

down the cursor indicated on the red rectangle on Fig. D.83. Moving up and down the same cursor it is 

possible to adjust the visualization dimensions of both diagrams (waterfall and frequency sweep). 

 

 

Fig. D.83: Waterfall visualization 

With mouse right-click on the lower part of the graphic, it is possible to select one of the FFT bands of the 

whole frequency range and the real time measurement will be performed into the selected single FFT 

band.  

 

Pushing “ALL” button, the real time measurement will be performed into the whole frequency range.    
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D.5 • CW GENERATOR BOX 

CW Generator is the so-called Internal Signal Generator Box. It is depicted in Fig. D.84. 

 

 
Fig. D.84: CW Generator Box 

The CW Generator has to be activated by checking flag RF ON after setting the frequency and the 

amplitude.  

The operator can quickly increase / decrease the value of the frequency according to the set frequency 

step pushing the black arrows. 

The Amplitude range is from +50 dBμV to +90 dBμV for the Frequency range from 9 kHz to 110 MHz. 

 

.  
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SECTION E: REPORT AND APPLICATION NOTES 

E.1 • REPORT BOX 

The Report box of the cockpit is the place you can summarize your test results in a form suitable for 

reporting and presentation (Fig. E.1). 

 

 
Fig. E.1: The Report Box 

In the Report box you can Load Test, make a Peak Search, Reset Zoom (if any), Export Data and 

Generate Report (see next paragraph E.2).  

Load Test will open the well-known Test Management table (Fig. E.2). 

 
Fig. E.2: Test Management in Report box 
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Here you can Load/delete a Test and Save Modifications to it, as usual. Pressing the Show Settings 

button, a summary of Test Settings is presented as a Table, with all information about measurement 

settings (Fig. E.3). 

 

 
Fig. E.3: Test Settings in Report box 

Remember that you can customize the Report Options information, under the menu: 

  

Tools => Customize => Report. 

A window summarizing the following information is apparent: 

 

Title Add a title to your Report 

Comment 1 to Comment 3  Add three lines of comments to your Report 

Show Date and Time Add current date and time to your Report 

Show Subrange Settings Add subrange information to your Report 

See Fig. E.5 for details. 

 

 

Fig. E.4: Report Options window 

E.2 • GENERATE A REPORT  

Once you have loaded a test and set all your supplementary information, you can easily generate a report 

by pressing the Generate Report button.  

After a few instants a window opens with your customized test report (Fig. E.5). 

Here you can make many actions as 

 

Export  Export as an Excel, PDF and Word file 
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Fig. E.5A: Report window (Page 1 / 2)  

 

Fig. E.5B: Report window (Page 2 / 2) 

In the headings you can navigate on different pages, print on paper, choose a print layout, see the page 

setup for different paper-format, and save it as a file: PDF, Excel and Word file are allowed (Fig. E.7). 

 

    

 
Fig. E.7: Navigation, Print, Print layout, Export as Excel / PDF / Word file 

Report can be opened in Word (any version), see next pages. 
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AFJ FFT3010 Report 

 

  

Report    Test: LED Device    WorkSpace: AFJ EMI Test Lab 
 

 

 

 

     

 

 

 

     

 

 

 

     

 
 

    

 

 

 

    

Test Summary 
 

   

                           

  

WorkSpace 
 

   

AFJ EMI Test Lab 
 

  

Test Name 
 

 

LED Test 
 

   

                           

                           

                      

14/01/2021 03.38 
 

   

   

Laboratory 
 

   

AFJ EMI Test Lab 
 

  

Date 
 

     

          

AFJ 
 

   

   

DUT 
 

   

LED Device 
 

  

Operator 
 

     

          

FFT SCAN 
 

    

    

Company 
 

   

AFJ 
 

  

Test Type 
 

      

           

 
 

   

    

Model 
 

   

100~240V 
 

  

 Specification 
 

     

           

220V_L2 
 

   

    

Serial 
 

   

 
 

  

Condition 
 

     

                

                           

           

 

 

    

    

Note 
 

       

               

                           

      

Unit: 
 

  

dBµV 
 

              

                           

     

Autom. 
 

  

-none- 
 

    

Setting 
 

 

Neutral 
 

  

                           

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Settings SubRange Summary 
 

  

                          

   

Range Number: 
 

1 
 

                 

                          

                          

   

Start Freq.: 
 

 

9.000Hz 
 

 

Stop 
Freq.: 

 

      

Step: 
 

 

46.8Hz/3kHz 
 

  

      

30.000.000Hz 
 

    

                      

                          

   

Trace 1: 
 

  

QPeak 
 

 

Trace 2: 
 

 

C_AVG 
 

  

Trace 3: 
 

 

-- 
 

   

                          

   

Bandwidth: 
 

200Hz/9kHz 
 

 

Measurment 
Time: 

 

1000 ms 
 

 

Attenuator: 
 

 

0 dB 
 

  

                          

    

Antenna/Probe: 
 

L2-16B LISN-L2 
 

 

Cable: 
 

- none -  
 

 

Amplifier/Atten.: 
 

 

PAT20M 
 

  

                          

                          

 

 

    

 



 

 

AFJ FFT 3010 AND FFT 3030 EMI RECEIVERS – Operating Manual – rev. 3.5 / 2023-03 

 

85 

 

 

 



 

 

AFJ FFT 3010 AND FFT 3030 EMI RECEIVERS – Operating Manual – rev. 3.5 / 2023-03 

 

86 

 

ID Frequency Probe Cable Atten. Detector Meter 
Read 

Meas 
Level 

Limit 
1 

Limit 1 
Dist. 

Limit 
2 

Limit 2 
Dist. 

P/F 

MU MHz dB dB dB Type dBuV dBuV dBuV dB dBuV dB P/F 

1 186kHz 0,05  19,94 QPeak 47,93 67,92 64,21 3,70   F 

2 261kHz 0,05  19,94 QPeak 44,99 64,98 61,40 3,58   F 

3 336kHz 0,05  19,94 QPeak 40,64 60,63 59,30 1,33   F 

4 411kHz 0,05  19,94 QPeak 34,85 54,84 57,63 -2,79   P 

5 483kHz 0,05  19,94 QPeak 30,48 50,47 56,29 -5,82   P 

6 633kHz 0,05  19,94 QPeak 29,05 49,04 56,00 -6,96   P 

7 558kHz 0,05  19,94 QPeak 28,59 48,58 56,00 -7,42   P 

8 150kHz 0,05  19,95 QPeak 36,62 56,62 66,00 -9,38   P 

9 22,119 0,10  19,98 QPeak 28,62 48,70 60,00 -11,30   P 

23 150kHz 0,05  19,95 C_AVG 22,21 42,21   56,00 -13,79 P 

10 186kHz 0,05  19,94 C_AVG 46,67 66,66   54,21 12,45 F 

11 264kHz 0,05  19,94 C_AVG 43,53 63,52   51,30 12,22 F 

25 300kHz 0,05  19,94 C_AVG 15,87 35,86   50,24 -14,38 P 

12 339kHz 0,05  19,94 C_AVG 38,88 58,87   49,23 9,64 F 

26 375kHz 0,05  19,94 C_AVG 13,91 33,90   48,39 -14,49 P 

13 414kHz 0,05  19,94 C_AVG 32,56 52,55   47,57 4,98 F 

19 450kHz 0,05  19,94 C_AVG 15,28 35,27   46,88 -11,61 P 

14 486kHz 0,05  19,94 C_AVG 26,94 46,93   46,24 0,69 F 

21 525kHz 0,05  19,94 C_AVG 12,80 32,79   46,00 -13,21 P 

16 561kHz 0,05  19,94 C_AVG 23,90 43,89   46,00 -2,11 P 

24 600kHz 0,05  19,94 C_AVG 12,22 32,21   46,00 -13,79 P 

15 636kHz 0,05  19,94 C_AVG 24,42 44,41   46,00 -1,59 P 

20 711kHz 0,05  19,95 C_AVG 13,27 33,27   46,00 -12,73 P 

18 783kHz 0,05  19,95 C_AVG 14,86 34,86   46,00 -11,14 P 

22 858kHz 0,05  19,95 C_AVG 12,68 32,68   46,00 -13,32 P 

27 18,051 0,10  19,98 C_AVG 15,38 35,46   50,00 -14,54 P 

17 22,119 0,10  19,98 C_AVG 24,75 44,83   50,00 -5,17 P 
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